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GETTING FAMILIAR WITH THE NEW LAYOUT
In this article:
1. Overview
2. View Menu
3. Resource Area
4. Schedule Area
5. Live Preview Area
6. Search
7. Alerts

OVERVIEW
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EasyWorship 6.4 introduces a new experience from previous versions, making it simpler
than ever to build and present a schedule. If you've used previous versions, you'll
recognize the flow: using the Resource Area on the bottom to build the Schedule Area
on the left, the Preview Area in the middle, and then present from the Live Area on the
right. You can still double-click any item in the Schedule or Resource Area to Go Live
immediately, and additional menu options have been tucked into menu drop-down
buttons located in the corners of each section of the interface.

VIEW MENU

There are now three options under the View Menu - Preview and Live, Preview and
Live Combined, and Live with Resource Preview. If you've been using EasyWorship
6, you'll be familiar with the Live with Resource Preview view.

Live with Resource Preview
This view shows a preview in the Compose section of the Resource Area, as well as in
the Schedule. The live output is shown in the Live Area. You can now compose quickly
using this view. Select the desired song in the Songs tab, then select the Themes tab.
Select a theme to use with the selected song. To go live, click the Play button above the
Compose section. Or, to add it to the Schedule, click the Add button.

Preview and Live
This view divides the top area into 3 separate parts - Schedule, Preview, and Live.
There is no Compose section in this view. Instead, select the desired song in the Songs
tab, then select the Themes tab. Drag the desired theme into the Preview Output to
change the theme of the entire song, or onto a single slide to change the theme of that
slide only.
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Preview and Live Combined
This view allows you to preview and go live in the same window. When you select a
resource, it will show up in the Live Area, but does not go live until you click Go Live. To
compose in this view, select the desired song in the Songs tab, then select the Themes
tab. Select a theme to use with the selected song. Drag the theme to the slides in the Live
Area.

RESOURCE AREA

A collapsible Resource Area now spans the bottom of the application instead of being
confined to the bottom left. At the top are five tabbed libraries: Songs, Scriptures, Media,
Presentations, and Themes. In the default view (Preview and Live), the Resource Area
has two columns: 1) Resource Library/Collections tabs on the left and 2) Library lists and
details in the middle. Additional menu options are now in drop-down buttons in the bottom
left of the Resource Library and Library lists/details Areas, including Add Item and Action
Menu buttons
. In the Library lists/details Area, you'll also notice an Icon View
drop-down with a slider that allows you to customize your view for thumbnails or list view
.
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Presentations - Presentations in the Resource Area will house any EasyWorship
presentations you build in EasyWorship and PowerPoint slideshows. You’ll now have a
complete searchable library of presentations at your fingertips. No need to search your
hard drive for a PowerPoint file when it’s right there in EasyWorship.
Themes - The Themes Area allows you to make templates that you can apply to scripture,
songs, and presentations. The responsibility of what used to be called backgrounds is
now handled between media and themes. Both will be available in the song editor for
convenient access. You’ll no longer have to load media items in two separate libraries to
have backgrounds available in the song editor.
Collections - The Resource Area now gives you the power to create collections based on
criteria you define, i.e., you can create a collection of songs that are written by the same
author, or create a collection of videos or images that have cross in the name.

SCHEDULE AREA

The biggest change to the Schedule Area is the addition of collapsible slide groups,
allowing you to drag-and-drop media to a single slide within a group or to the entire group
at one time. Additional menu options are included in drop-down buttons in the top right of
the Schedule Area, including an Icon View drop-down with a custom slider and an Action
Menu drop-down
.
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LIVE PREVIEW AREA
The Live Preview Area allows you to see the current live slide that the audience is seeing
as well as any sub-slides that are a part of the active slide group, e.g., multiple slides
within a song, looping presentation, or a long scripture reference. This is different than
previous versions where the middle Preview Area was for previewing what was queued
to Go Live.

SEARCH

Search has been moved from above the Compose Area to above the Media list. Also,
previously limited to songs, Search has now been expanded to all libraries within the
Resource Area with two different search modes. Search by resource title, by scripture
reference, or by keyword. Toggle between search modes by clicking the icon on the left
side of the search box
.
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ALERTS

Alerts have been added to the toolbar at the top of the application. Click Alerts to add a
nursery alert to your live output. You can set the appearance of the alert in the Alerts
options, located in Edit > Options... > Alerts. For more information on the available
settings, see Alert Options.

Back to Top
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BUILDING YOUR FIRST SCHEDULE
In This Article:
1. Overview
2. STEP 1: Build with Drag & Drop
3. STEP 2: Edit Schedule Items
4. STEP 3: Save & Transfer Your Schedule
5. STEP 4: Present Your Schedule

OVERVIEW
The Schedule Area in EasyWorship allows you to build a playlist or "set list" of items you
want to present during your worship service (e.g., songs with backgrounds, scriptures,
PPT slides for the sermon, live camera feeds, a mini-movie for offering or a sermon
illustration, a website, and lots of other options). This article will introduce you to the basics
of how to build your first Schedule, how to edit and re-order the items within the Schedule,
and how to save it as a file so that it can be shared with other users.
To get started, let's add some items to the Schedule Area.

STEP 1: BUILD WITH DRAG & DROP
Add Items
Adding items to your Schedule is as easy as dragging and dropping a song, scripture,
media item, or presentation from the Resource Area below to the Schedule Area. Try
adding a few items to your Schedule.
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1. Let's say you want to start your next service with a mini-movie opener. To add a minimovie, go the Resource Area and click the Media tab.
2. Select Videos from the list on the left.
3. Click the + (add) button below, search for your mini-movie file, then click Open to add
the file to your Resource Library.
4. Now, just drag-and-drop the video file from the Resource Area to your new
Schedule.
Adding more items to your Schedule is just as easy. To learn more, see Add a Song or
Add a Scripture.

Re-Order Items
Drag-and-drop Schedule items around to re-order your set list.

Customize Your View
Customize the icons in the Schedule Area as small, medium, large or list view. Just click
the drop down arrow at the top of the Schedule Area and use the slider to customize the
icon view.
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Assign a Background or Audio to Songs
It's easy to add a background, camera feed, or audio track to your song slides.
1. Click on the Media tab in the Resource Area.
2. Select Videos, Images, Feeds, or Audio from the left.
3. Drag an item from the Resource List Area on the right and drop it on top of a song
in the Schedule Area. That item has now been assigned to the song in the Schedule.
The song's master thumbnail in the Resource Area will reflect your changes. (You
can assign audio to a slide or song even if you have already have a background
assigned to it.).
You can also assign a background or audio to an individual slide within a group of slides.
1. Click on the arrow next to the song slide in the Schedule Area.The slides will
expand so that you can see each individual slide for the song.
2. Now, drag a media item and drop it onto an individual slide.
Dragging a media item onto the master slide of a song will apply the background to all
slides, even slides that already have a background assigned to them. (For more about
customizing slides, see Customize Song Slides).
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NOTE: You can right-click on any theme in the Themes Area and click Set as Default. You
can set a default for songs, scriptures, and presentations.

Back to Top

Creating Announcement Loops
Announcement loops can be created in either EasyWorship or PowerPoint and loaded
into the Presentations tab. The announcement loop will be added to the Schedule from
the Presentations tab where all EasyWorship Presentations and PowerPoint slideshows
are stored.
For more information on how to create announcement loops, Announcement Loops.

STEP 2: EDIT SCHEDULE ITEMS
To modify a song, scripture or presentation that is already in the Schedule Area:
1. Right-click on the item in the Schedule.
2. Select Edit Item.
3. When the Schedule Editor appears, make the changes that are needed.
4. Click OK to save the changes to the Schedule.

Add a Note or Reminder to a Schedule Item
If you want your tech team or a volunteer user to know something about a particular
Schedule Item, just add a note to it. It takes seconds to create, and will appear under the
item name in the Schedule Area.
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1. Right-click on any item in the Schedule Area.
2. Select the option to Edit Notes. The Notes field will now contain a blinking cursor.
3. Type a note or reminder.
4. Click outside the Notes field to save the note to that item.

STEP 3: SAVE & TRANSFER YOUR SCHEDULE
You'll want to save your Schedule at some point. Maybe you need to email your Schedule
file to someone, or save it to a memory stick or cloud service. No matter what you need to
do with your new Schedule file, follow these steps to get started.
1. Click the Save icon in the main toolbar or click File in EasyWorship's main menu and
select the option to Save Schedule.
2. Name your Schedule file and click Save. If you're going to run your Schedule from
the same computer, you have the option to uncheck the Pack files in schedule box.
This will save space on your computer. If you'll be transferring the schedule to
another computer, make sure that box is checked. Everything you add to the
Schedule will be packed into the Schedule when you save it...all in one file. Simple!
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It's an easy way to take one file to another computer and open it to start your worship
service.
NOTE: EasyWorship will save your new Schedule file to a default location. If you would like
to save to another location (e.g., memory stick), be sure to navigate to that location before
clicking the Save button.

Open & Use an Existing Schedule
If you want to use a Schedule file you've received from someone else, it's easy to get
content from the Schedule to the screen.
1. Click the Open icon in the main toolbar or click File in EasyWorship's main menu and
select the option to Open Schedule.
2. Navigate to the desired file and click Open.
3. When the Schedule opens in EasyWorship, select an item in the Schedule Area and
click Go Live
. EasyWorship automatically selects the next item in the Schedule
so all you need to do is click Go Live again to send the next item to the screen. If you
don't see the item on the live screen, make sure you've clicked the Live button
on
the far right of the main menu.

STEP 4: PRESENT YOUR SCHEDULE
1. Select the first item in the Schedule and click the Go Live button

on the toolbar.

If you don't see the item on the live screen, make sure you've clicked the Live button
on the far right of the main menu.
2. When you are ready to send the next item to the screen click Go Live again.
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Using Logo, Black, Clear

Logo Button
At the beginning or end of a presentation, you might want to display a generic logo or title
screen. The Logo button allows you to quickly display an image (or video) that has been
assigned as the logo background. Here's how to assign an image as the logo:
1. In the Resource Area, click on the Media tab, select Images or Video from the
Resource Library on the left.
2. Right-click the image in the Resource List Area to the right.
3. Select Set As Logo Background.
Black Button
Mistakes happen. When you need a quick save, the Black button is a quick and easy
way to transition the entire screen to black.
Clear Button
The Clear button removes text from the screen while leaving the background running.
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Back to Top
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DUAL MONITOR SETUP
In This Article:
1. Video Card Configurations for Windows Extended Desktop
2. Dual Monitor Troubleshooting
3. Enable Windows Extended Desktop
4. Setting Up EasyWorship to Use Your Second Monitor
5. Intel Graphics Monitor Setup
EasyWorship is designed for dual monitor display. That means it can produce two
different displays at the same time. The first display--Monitor #1 or the primary monitor-goes to the control screen, which is what the operator sees. The second display--Monitor
#2 or the secondary monitor--goes to the output screen that is projected to the
congregation (this could be a TV, projector, or LCD screen). This kind of "Dual Monitor
Display" makes it possible for an operator to be editing the Schedule Area in EasyWorship
while the congregation is viewing only the current song, scripture, video, presentation, or
feed.
EasyWorship uses Windows extended desktop to accomplish this. The following are
three different video card configurations that will allow you to use Windows Extended
desktop:

VIDEO CARD CONFIGURATIONS FOR WINDOWS EXTENDED
DESKTOP
1. A single video card with two outputs. Works with desktop PCs only.
(Recommended)
2. A laptop with a video output (VGA, DVI or HDMI) on the side or back of the laptop.
3. Two video cards with a single output on each card. Works with desktop PCs only.
(Not recommended)
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Common ways to set up a computer for dual monitor output.
1. EasyWorship may be set up with a single monitor on the desk to control the software
(Monitor #1) and with a projector as the secondary output (Monitor #2).
2. Customers using laptops will use their laptop monitor as the control monitor (Monitor
#1) and the output on the side or back of the laptop for output to the audience
(Monitor #2).
3. You may also add a video splitter to the secondary output. This would allow you to
have two secondary outputs (live screens) or a second monitor on the desk as well as
a secondary output for the audience.
NOTES: See Enabling Windows Extended Desktop for instructions on how to check a
computer for Dual Monitor compatibility and for instructions on setting up Dual Monitors to
use with EasyWorship.

DUAL MONITOR TROUBLESHOOTING
If your problem cannot be resolved by following the steps below, contact our Customer
Support Team via email at support@easyworship.com.
ISSUE

CAUSE

RESOLUTION

1.

I see the same thing on
my second monitor as I
see on my primary monitor.

Your windows desktop has
not been extended to the
second monitor.

Enable the windows extended desktop. See below:
Enabling Windows Extended Desktop.

2.

I enabled the Windows
extended desktop, but it
disables itself after I apply
the setting.

You have an Intel Graphics
card, or you do not have
your projector connected to
your secondary video port,
or the projector is not turned
on.

Use the instructions in Intel
Graphics Monitor Setup
to enable the windows
extended desktop for your
Intel Graphics card. Connect your projector or secondary monitor to the
secondary monitor port on
your graphics card and
make sure that the monitor,
or projector, is turned on.
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3.

Windows extended
desktop is enabled, but
EasyWorship still displays the output on my
primary monitor.

The secondary monitor is
not selected as the output
monitor in EasyWorship.

Click the Edit menu, then
Options. In the Live settings, Select Monitor 2
(Secondary) for the Output
monitor. Click OK.

Back to Top

ENABLE WINDOWS EXTENDED DESKTOP
1. Open EasyWorship.
2. Click on the Edit menu.
3. Click Options....
4. The Options dialog box appears.

5. Select the Live tab at the upper left.
6. In the section titled Live Options, click the Monitor Setup button.
7. EasyWorship will open the Screen Resolution dialog box.
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,

8. Select monitor 2. (If display 1 and 2 boxes do not appear, your computer does not
have dual monitor capability, or you do not have a projector or monitor plugged into
the secondary video output on the computer.)
9. Select the Extend my Windows desktop onto this monitor or select Extend
these displays from the drop down list.
10. Set the Screen area resolution.
Standard 4:3 - 800x600 or 1024x768
Widescreen 16:9 - 852x480, 1280x720 or 1920x1080
Widescreen 16:10 - 1280x768, 1280x800 or 1440x900
11. Verify the color setting for monitor number 2 is set to 32 bit.
12. Click Apply, then OK. If prompted to keep the settings, click Yes.
13. Now you need to set up EasyWorship to use your second monitor. To do this, follow
the instructions below.
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SETTING UP EASYWORSHIP TO USE YOUR SECOND MONITOR
EasyWorship will normally find the secondary display and automatically send the output to
that screen. However, you may need to set up the output screen manually. The
instructions below will walk you through the process.
1. Open EasyWorship.
2. Click on the Edit menu.
3. Click Options....
4. The Options dialog box appears.

5. Select the Live tan at the upper left.
6. In the section titled Live Options, click the Output Monitor drop-down and select
Secondary Monitor.
7. Click OK.
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INTEL GRAPHICS MONITOR SETUP
1. Right-click on the Windows Desktop.
2. Click Graphics Properties.
3. Under Devices or Display Devices, click on the Extended Desktop option.
4. The Primary Device should be set to Notebook or Built-in-Display.
5. The Secondary Device should be set to Monitor.
6. Click OK.
7. Open EasyWorship
8. Click on the Edit menu.
9. Click Options.
10. Under Live, go to Select Output Monitor and select Secondary Monitor from the
drop down list.
11. Click OK.

Back to Top
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DOWNLOADING FREE MEDIA
EasyWorship comes with a collection of free media that you can download within the
software. The following instructions will walk you through downloading your free media.
1. Open EasyWorship.
2. Click on the Web Button on the toolbar at the top.
3. Select Media at the top left of the web area if you are not already in the media store.

4. Click My Account at the top right of the media store page.
5. Click the DOWNLOAD FREE MEDIA button.
6. Hover your mouse over each media item and a download button will be provided.
7. Click the appropriate download button.
EasyWorship 6 will support either mp4 or wmv file formats, so you can download
either format. When provided the option for HD content, you may need to select SD if
your computer seems to lag when play HD video files through EasyWorship.

- 22 -

EasyWorship 6 Manual: Downloading Free media
8. The downloaded items will appear in the media area in their respective folders
(videos or images).
If the image or video thumbnail looks faded, that means EasyWorship is still
downloading the file.
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PURCHASING & INSTALLING BIBLES
EasyWorship has many free bibles available. There are also many copyrighted bibles
available for purchase as add-ons.

1. Open EasyWorship.
2. Click on the Scriptures tab in the Resource Area.
3. At the bottom of the Scriptures list on the left (list of currently installed bible versions),
click the link for More Available…
4. In the list of available Scripture versions on the right you can see a full list of free and
purchasable bible versions. If the bible you want to install is free, click the Free button
next to it to install.
5. If a bible you want to add is not free, click the Buy button on the right. In the new
window, log in to your EasyWorship account. If you do not have an account, click on
Create New User and enter in the appropriate information to create an account.
6. Once you are logged in, make sure you’re connected to the correct Organization and
click Buy.
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7. A window will open to complete your purchase. Enter your payment information and
click Place Order. When the order is complete, EasyWorship will automatically
download and install the bible.
8. If you purchased a bible on easyworship.com or worshipmedia.com, the bible will
show as installed when you’re logged into EasyWorship with your account.
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ANNOUNCEMENT LOOPS
Announcement loops are a great pre- or post-service communication tool. Whether you're
sending announcements to a lobby kiosk or presenting on the main screens in your
auditorium, this article will show you how to get started.
Slide loops are created in the Presentations Area of EasyWorship. When you're ready
to play the loop, simply drag-and-drop it to the Schedule Area and click Go Live or just
double-click it to send it to the screen. The slides within the Presentation will loop until you
Go Live with the next item in the Schedule.
Let's get started creating an announcement loop.

1. First, create a new presentation (click on the Presentations tab in the Resource
Area and click the + [add] icon below) or right-click an existing item in the Resource
Area or the Schedule Area and select the option to Edit Item.
2. Once the Presentation Editor opens, click the Inspector button in the upper right
corner.
3. Click Presentation on the left and check the option to Loop Presentation.
4. Next, click Transition under the Slide settings on the left.
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5. Set the transition and any other options you wish to set.
6. Change the Advanced Slide option to Automatically.
7. In the field for After, set the number of seconds you wish to wait before transitioning
to the next slide (Loop Slide sets that slide to loop continuously until you select
another slide).
8. Click Apply to Theme to apply this setting to all of the slides in the presentation.
9. Close the Inspector and enter a name in the Title field at the top of the Editor
Window and click OK to save your changes.

NOTE:These instructions apply only to EasyWorship presentations, songs or
scriptures. PowerPoint loops cannot be set up using these instructions.
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COMPOSE

OVERVIEW
For on-the-fly editors and designers, the Compose Area is the quickest way to change a
background, select an audio track, or apply a theme to a song or scripture at the last
minute. In the Compose Area, you can choose to send an item to the live screen
immediately, or add it to the Schedule for later.

The location and presence of the Compose Area depends on the selected view in Easy
Worship.
The Live with Resource Preview view shows a preview in the Compose section of the
Resource Area, as well as in the Schedule. The live output is shown in the Live Area.
You can now compose quickly using this view.
The Preview and Live view divides the top area into 3 separate parts Schedule, Preview, and Live. There is no Compose section in this view.
The Preview and Live Combined view allows you to preview and go live in the same
window. There is no Compose section in this view.
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USING COMPOSE
1. Click the Songs or Scriptures tab in the Resource area.
2. Select the song or scripture you want to compose.
3. Click the Themes tab in the Resource area.
4. Select a theme to use with the selected song.
5. To go live, click the Play button above the Compose section. Or, to add it to the
Schedule, click the Add button.
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DISPLAY FOLDBACK (STAGE DISPLAY)
In this article:
1. What Is Display Foldback?
2. Hardware Options
3. Setup for NVIDIA GeForce or Secondary Graphics Card
4. Setup for the Matrox DualHead2Go
5. Matrox DualHead2Go Connection Examples

WHAT IS DISPLAY FOLDBACK?
Your audience is first, but your stage needs support, too. While the audience sees the
presentation on the main screens, Stage Display lets the stage see a custom display with
the current presentation or video, a preview of the next scheduled item, a clock and
private alerts. This goes for PowerPoint presentations as well. EasyWorship even lets the
stage see variable thumbnails for previous, current, and next slide.

HARDWARE OPTIONS
If you want to take advantage of the Stage Display (Foldback) feature in EasyWorship,
you will need some basic hardware and a little patience to set everything up (but no
worries, we'll help you, and everyone will thank you later!). This article will explain what
you need to get started along with step-by-step setup instructions. In order to use Display
Foldback in EasyWorship, you will need one of the following hardware solutions (You can
order any one of these online from NewEgg.com or TigerDirect.com):
1. Matrox DualHead2Go
2. Second Video Card
3. NVIDIA GeForce GTX graphics card with surround technology (we recommend
using 650/750 or 690/790 models)
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SETUP FOR NVIDIA GEFORCE OR SECONDARY GRAPHICS
CARD
We'll get into setup instructions for the Matrox DualHead2Go further down in this article,
but first let's look at setup for the NVIDIA GeForce GTX or a Secondary Graphics Card.
NOTE: You may also use another PCI Express X16 video card or a single NVIDIA GeForce
GTX graphics card to control the Front of House (what the audience sees) and Stage Display
(Foldback) screens. See the Stage Display (Foldback) Article in our Knowledge Base.
This will help you to find the best video cards to use for Stage Display purposes.

Front of House Settings
1. In EasyWorship, click the Edit > Options....
2. Under Live, click the Output Monitor drop-down, then select the monitor you wish
to use for the Front of House display. This is usually Monitor 2 (Secondary) from the
drop down list next to Output Monitor).
3. Click OK.

Foldback Settings
1. In EasyWorship, click the Edit > Options....
2. Under Foldback, check the box to Enable support for display Foldback (stage
display).
3. Under Select Output Monitor, select the monitor you wish to use for Display
Foldback. This is usually Monitor 3 from the list next to Output Monitor.
4. Click OK.

SETUP FOR THE MATROX DUALHEAD2GO
When using a Matrox DualHead2Go box, the secondary output from your computer's
video card plugs into the input on the Matrox box. The Matrox box also has two outputs
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that are spanned across two monitors/projectors/tv’s. The screen resolution for that
output is double-wide. If that sounds too technical, here are some examples that should
help you picture how it works.

Example 1
Imagine you have two projectors. You know that one is for the audience and the other is
projecting onto the back wall for the stage to see, but Matrox just sees these as two
outputs side-by-side. Now, if each projector has a resolution of 1024x768 (that's 1024
pixels wide and 768 pixels tall), then together (side -by-side) the resolution will be
2048x768. When you connect the Matrox box to the two projectors, the combined
resolution will be 2048x768. That's all the Matrox box needs to know. EasyWorship will
communicate that to the Matrox box, as well as which graphics and words to send to the
first projector for the audience, and which graphics and words to send to the projector for
the stage. As long as you set EasyWorship up correctly, it will take care of telling the
Matrox box what to do.

Example 2
Here's another example using a simple diagram (below). Imagine two pieces of paper
next to each other where the left piece (piece 1) is what goes to your computer monitor
and the right piece (piece 2) represents what the Matrox box is sending to the two
projector screens. Since the output resolution on piece 2 is double-wide, we can split it in
the middle and send the first half to the first projector for the audience and the second half
to the second projector for the stage to see.

Back to Top
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Finding Left Positions (sounds technical, but we'll make it easy)
To tell the Matrox box what it needs to make Display Foldback work, EasyWorship needs
to know the left position of the Front of House screen, the left position of the Display
Foldback screen, and the width and height of both.
1. Left Position for Front of House: To find the left position for the Front of House screen
(piece 2), we just need to know the width of Monitor 1 (piece 1). In the example
above, the width of piece 1 is 4. Piece 1 goes from 0 to 4, so piece 2 starts its left
position at 4. Not too bad.
2. Left Position for Display Foldback Screen: To find the left position of the Display
Fodlback screen (second half of piece 2), we need to know the distance from the left
side of piece 1 to the middle of piece 2. We will add the width of piece 1, which is 4, to
half the width of piece 2, which is 5 (or 4+5=9). So, in the example above, the left
position of the Display Foldback screen would be 9.
If you were using the numbers from the above diagram to set the custom positions in
EasyWorship, the left position for the Front of House screen would be 4, and the left
position for the Display Foldback screen would be 9. The width for each would be 5 since
they are both using half of the secondary monitor resolution (10/2=5). The height would
be whatever the height is from the resolution setting.
Now, let's look at how this simple illustration works with actual monitor resolutions.

Finding Width and Height of Both Monitors
Now, we can replace the numbers from the example above with the actual numbers from
the resolutions your monitors and projectors are using.
1. Right-click on the Windows desktop.
Windows Vista users will select Personalize then click the Display Settings link.
Windows 7 and 8 users will select Screen Resolution.
Windows 10 users will select Display Settings.
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2. Click each monitor to determine its resolution (width and height). The size will be
displayed in the Resolution Area, e.g., 1024x768, 1920x1080, etc.
Example Screen Resolutions (below):
1. Monitor 1: 1024 pixels wide by 768 pixels high (1024x768)
2. Monitor 2: 2048 pixels wide by 768 pixels high (2048x768)

IMPORTANT: These resolutions may be different on your computer. Write this information
down for use in the steps under Front of House Settings and Foldback Settings. If the
second monitor is not already set to a double-wide resolution, change the change the
resolution in the windows display settings to a double-wide resolution.

Back to Top
Common double-wide resolutions to use:
1. Standard 4:3 - 1600x600 or 2048x768
2. Widescreen 16:9 - 2560x720
3. Widescreen 16:10 - 2560x768
If one of these resolutions is not available, you may need to contact Matrox Technical
Support (www.matrox.com/graphics/en/support/).

Front of House Settings
1. In EasyWorship, click the Edit > Options...
2. Under Live, click the Output Monitor drop-down, then select Custom Position.
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3. In Output Position, set Left to the width of Monitor 1, set Top to 0, set Width to half
the width of Monitor 2, and set Height to the height of Monitor 2.
4. Click OK.
Using the example illustration below, your custom position settings in EasyWorship for
Front of House (Live Output Monitor) would be the following:
1. Left: Width of Monitor 1 = 1024
2. Top: 0
3. Width: Width of Monitor 2 (2048) divided by 2 = 1024
4. Height: Height of Monitor 2 = 768

NOTE: Your screen resolutions probably will not match the example above. To determine the
values needed to correctly set up EasyWorship for your situation, see Finding Left
Positions and Finding Width and Height of Both Monitors instructions above.

Back to Top

Foldback Settings
1. In EasyWorship, click the Edit > Options...
2. Under Foldback, check the box to Enable support for display Foldback (stage
display).
3. Under Select Output Monitor, select the monitor you wish to use for Display
Foldback. This is usually Monitor 3 from the list next to Output Monitor.
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4. In Custom Position, set Left to the width of Monitor 1 + half the width of Monitor 2,
set Top to 0, set Width to half the width of Monitor 2, and set Height to the height of
Monitor 2.
5. Click OK.
Using the example illustration below, your custom position settings in EasyWorship for
Foldback would be the following:
1. Left: Width of Monitor 1 (1024) + half the width of Monitor 2 (1024) = 2048
2. Top: 0
3. Width: Width of Monitor 2 (2048) divided by 2 = 1024
4. Height: Height of Monitor 2 = 768

NOTE: Your screen resolutions probably will not match the example above. To determine the
values needed to correctly set up EasyWorship for your situation, see Finding Left
Positions and Finding Width and Height of Both Monitors instructions above.

Back to Top

MATROX DUALHEAD2GO CONNECTION EXAMPLES
The Matrox DualHead2Go can support a maximum of two outputs: either two Front of
House outputs or one Front of House output and one Display Foldback output. If you need
a Display Foldback output as well as two Front of House outputs, you'll need to add a
splitter to your setup. Here are two illustrations that show the Matrox DualHead2Go
without a splitter (for Display Foldback and one Front of House output) and with a splitter
(providing Display Foldback and two Front of House outputs).
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Without a Splitter

With a Splitter

In the diagram below, a switcher has been added to the configuration, allowing you to
show either the Foldback view on the Foldback screen or the Front of House view on the
Foldback screen.

Back to Top
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DVD CLIPS
In This Article:
1. Intro to the DVD Feature
2. DVD Clip Editor Overview
3. Create a DVD Clip
4. Using a DVD Clip in the Schedule
5. Edit a DVD Clip
6. Delete a DVD Clip
7. Setting DVD Region
8. DVDs Explained

INTRO TO THE DVD FEATURE
EasyWorship lets you use your computer's DVD drive to show segments of a DVD during
a presentation or service, e.g., a missions update, sermon illustration or service intro.
Quickly select entire segments or chapters of a movie, or set custom In and Out points to
show only a short clip. EasyWorship was not designed to copy or burn video files from a
DVD. Instead, EasyWorship lets you create custom "markers" that tell EasyWorship
exactly what to play from the DVD. That means the DVD has to be in the DVD drive for
this feature to work.

Layout
To start exploring the DVD feature, click the Media tab in the Resource Area. Then, click
the DVD icon in the Media Library (see illustration below). There are three icons across
the bottom of the DVD clip library.
1. Add New

: Click this icon to open the DVD Clip Editor window and create a new

DVD clip.
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2. Action

: Click this icon to add a new DVD clip, edit or delete a selected clip,

customize the thumbnail view, customize the clip sort order, or refresh your clips.
3. Thumbnail View

: Click this icon and use the slider to customize the thumbnail

view in the DVD clip library.

DVD CLIP EDITOR OVERVIEW
To access the DVD Clip Editor, right-click anywhere in the DVD clip library area and
select Add New DVD Clip... from the pop-out menu, or click the Add New icon. If a DVD
is in the DVD drive when the DVD Clip Editor window pops up, EasyWorship will begin
playing the DVD just like a normal DVD player. Using your mouse, click on the chapter
menu in the preview window and navigate to the desired chapter or segment. The DVD
Clip Editor gives you a number of options for selecting clip segments and adjusting clip
volume.
For step-by-step instructions on creating a DVD clip using the DVD Clip Editor, see
Create a DVD Clip.
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Properties Tab

1. Play / Pause: The play/pause button starts and stops the video playback.
2. Fast-Forward / Rewind: Single clicking skips forward or backward one chapter.
Holding the FFW or RWD buttons down will fast forward or rewind the video.
3. Menu: button allows you to access the DVD Title Menu, Root Menu, set subtitle
options, Audio options angle and load the chapter menu.
4. Continuous Play / Repeat: button allows you to loop the dvd clip you are viewing or
let it stop at the end of the clip.
5. Mute & Volume: button and volume slider only controls the audio while working with
the DVD clip. The audio will not be muted on playback.
6. Select Drive: Select the DVD drive that currently has a DVD disk in it. This is
automatically selected if you only have one DVD drive.
7. Title : Type the name of the DVD clip in this field.
8. Thumbnail: Click the thumbnail box on the right to set the thumbnail. (This takes a
snapshot of what is currently in the player window)
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9. Clip Properties: Start Position is the time at which the DVD clip will start. Use the up
and down arrows to manually adjust the time. Mark In sets the start position of the
DVD clip. Click this button as the DVD clips plays to set the start position. End
Position is the time at which the DVD clip will end. Use the up and down arrows to
manually adjust the time. Mark Out sets the end position. Click this button as the DVD
clips plays to set the end position. Reset simply resets the Start and End Points.
10. Mark Entire Segment: Selects the whole DVD, or in the case of an iWorship DVD,
selects the start and end point of the song you are currently viewing.
11. Aspect Ratio: Allows you to maintain the aspect ratio, stretch or zoom the video.
12. Audio Properties: Allows you to change the volume of the DVD clip when you go
live with it. The volume slider allows you to set the volume of the DVD clip for
playback to the audience. Mute allows you to mute the audio on the DVD clip if you
don’t wish to use the audio portion of the DVD.
Back to Top

Info Tab
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1. Title: Enter the name of the DVD clip in this field.
2. Author: Enter the Author in this field.
3. Copyright: Enter copyright info in this field.
4. © Button: Pressing the copyright logo button adds the copyright logo to the
copyright field.
5. Description: This drop down allows you to enter a description for the DVD clip.
6. Tags: This drop down allows you to enter tags for the clip.

CREATE A DVD CLIP
1. Insert a DVD into the DVD drive.
2. Click on the Media Tab in the Resource Area.
3. Click on the DVD Icon in the Media Library on the left.
4. Right-click anywhere in the DVD clip library area and select Add New DVD Clip
from the pop-out menu, or click the Add New (+) Icon at the bottom of the DVD clip
library area.The DVD Clip Editor window will appear.
5. Type a clip name in the Clip Name field.
6. Using your mouse, click on the DVD chapter or title menu in the preview window and
navigate to the desired chapter or segment.
7. As the selected DVD clip plays, click the Mark In button to select the beginning of
your clip.
8. Click the Mark Out button to select the end of the clip.
9. The Preview button will allow you to preview your edited clip in the window. Click the
Edit button to resume editing.
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10. Scroll the clip to find the frame you wish to use for a thumbnail and click Set
Thumbnail.Click OK.
11. The clip and thumbnail will appear in the DVD clip database.
NOTES: To play an entire chapter or segment, click the "Mark Entire Segment" button. For
Integrity iWorship DVDs, and others like it, you can click "Mark Entire Segment" when a
worship track starts playing. EasyWorship will set the Mark In and Mark Out points at the
beginning and end of the song for you.

WARNING: If the wrong region or no region is set for the DVD drive in your computer, you
will be able to create clips, but will NOT be able to play them back after removing and
reinserting the DVD into the drive. To learn how to set the region for your computer's DVD
drive, see.Setting DVD Region below.

Back to Top

USING A DVD CLIP IN THE SCHEDULE
1. Select a DVD clip in the from the DVD section of the Media tab.
2. Drag-and-drop the clip into the Schedule.
3. When it is time for the DVD clip to be played in the service, just click Go Live .
NOTES: To Go Live with a DVD clip directly from the database, double-click it. DVD clips
can be transferred via the schedule to another computer, but the DVD has to be in the drive
for the clip to play.

EDIT A DVD CLIP
1. Right-click a DVD clip in the from the DVD section of the Media tab.
2. Select Edit.
3. The DVD Clip Editor window will appear. Make the desired changes.
4. Click OK to apply the changes.
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DELETE A DVD CLIP
1. Right-click a DVD clip in the from the DVD section of the Media tab.
2. Select Delete.
3. Click Yes on the prompt that appears to verify that you want to delete the clip.

SETTING DVD REGION
In order to create DVD clips in EasyWorship, the DVD region has to be set on the DVD
player in the computer. Many DVD drives come from the factory with no region set. If the
wrong region or no region is set, you will be able to create clips, but will not be able to play
them back after removing and reinserting the DVD into the drive. Follow the instructions
below to set the region on the DVD drive in the computer.
1. Open Computer or My Computer or This PC.
2. Right-click the DVD drive.
3. Click Properties.
4. A properties window will appear.
5. Click the Hardware tab.
6. Select the DVD drive from the list.
7. Click the Properties button at the bottom.
8. The properties window for the DVD drive will appear.
9. Click the Changes settings button at the bottom of the General tab.
10. Click the DVD Region tab.
11. Select the appropriate country.
12. Click OK.
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NOTE: The DVD region can be changed a maximum of 5 times.

DVDS EXPLAINED
EasyWorship lets you use your computer's DVD drive to show segments of a DVD during
a presentation or service, e.g., a missions update, sermon illustration, or service intro.
Quickly select entire segments or chapters of a movie, or set custom In and Out points to
show only a short clip. This is different than capturing a DVD feed through a capture card.
It's also different than copying or burning video files from a DVD. Instead, EasyWorship
lets you create custom "markers" that tell EasyWorship exactly what to play from the
DVD. That means the DVD has to be in the DVD drive for this feature to work.

DVD Structure
The video content in a DVD is divided into titles and menus. Titles are further divided into
units called parts of titles (PTTs). More often, these are called scenes, chapters, or
segments. These could be compared to using folders and sub-folders in the directory tree
structure of a computer. The viewer can navigate to specific titles or chapters within titles.
Each individually separated video file on a DVD may be referred to as a segment.
The author of a DVD decides how to divide the content into titles and chapters. When a
DVD contains a feature-length film, the entire film is often placed in one title or segment,
and sometimes divided into chapters for the individual scenes. Extra features on the DVD,
such as trailers or deleted scenes, are placed in separate titles or segments. However,
these divisions are arbitrary, and many DVDs are organized differently.
The EasyWorship DVD editor can play the entire movie, predefined segments, or you can
select parts of the DVD called clips. On any DVD, you may set Mark In and Mark Out
points to edit a clip. You may define a clip name for that edited clip. The DVD from which
you wish to play a clip must remain in the DVD-ROM drive. EasyWorship does not copy
the DVD or segments, only a path to turn on that selected segment or clip. If you have
multiple drives, EasyWorship will remember the drive from which you edited your specific
clip. Multiple clips or segments may be chosen from your DVD.

Back to Top
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FEEDS
In this article:
1. Overview
2. Add a Feed
3. Edit a Feed
4. Delete a Feed

OVERVIEW
EasyWorship can project images from your computer through external devices (e.g.,
DVD, VHS, Camera[s], Mixer) using a capture card. Most capture cards are PCI cards
that are installed into PCI slots on the motherboard of your computer. Each capture card
has its own input connections. Some are RCA (composite) jacks, some are S-video, and
some are FireWire IEEE1392. It is important that you determine the type of interface
cable desired before you order your capture card.
NOTE: FireWire IEEE1392 has some latency that is noticeable. This option may not be
desirable if your audience is watching the source and output screen at the same time (e.g.,
IMAG). Some capture cards do not work well with multiple cards of the same type. See
System Requirements at EasyWorship.com/Support.

ADD A FEED
1. Open EasyWorship.
2. In the Resource Area, click the Media tab and select Feeds from the Media Library
on the left.
3. Click the Action Menu button

at the bottom of the List Area in the middle.

4. Select the option to Add New Feed, which brings up the Feed Editor window.
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5. Under the Available Input Devices you will see <unassigned> and below that you
will see any input devices that are connected (e.g., a capture card, a web cam, or a
USB input device).

6. Click the input device to which you want to connect.
7. Type a name for the device in the Name field. Example: Webcam.
8. Cllick the camera icon to select the type of device (options include a Camera, Mixer,
DVD player, and Misc Player).
9. Under the Device Options you can customize the following properties:
Resolution: Defaults to 640 x 480, but can be changed from 1280 x 720 to 160
x 480.
Frame Rate: Defaults to 30 FPS.
Color Space: YUY2 or MJPG.
Video Standard: NTSC or PAL. This setting is automatically populated.
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Aspect Ratio: defaults to Automatic, but can be changed to Maintain, Stretch,
or Zoom.
Audio Properties: allows you to change the volume of the feed when you go
live with it. The volume slider allows you to set the volume of the feed for
playback to the audience. Mute allows you to mute the audio on the feed if you
don’t wish to use the audio portion of the feed.
10. Click OK when you are done.
11. The added device is listed in the Feeds Library in the Resource Area. To add
additional devices repeat steps 1-10.

EDIT A FEED
1. In the Resource Area, click the Media tab and select Feeds from the Media Library
on the left.
2. In the list area in the middle, right-click on the device and select Edit. The Feed
Editor will open, providing the same options described above.
3. Make the desired changes and click OK.

DELETE A FEED
1. In the Resource Area, click the Media tab and select Feeds from the Media Library
on the left.
2. In the list area in the middle, right-click on the device that you want to delete and
select Delete.
3. A message appears asking you if you want to permanently delete the feed.
4. Click Yes to delete the feed.

Back to Top
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IMAGES
In this article:
1. Display Images
2. Add New Images
3. Right-Click Features
4. Drag & Drop Features
5. Image Properties Editor

DISPLAY IMAGES
In the Resource area:
1. Click the Media tab.
2. Click the Images icon in the Resource Library below, then drag and drop the image
to the Schedule Area.
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3. Select the image in the Schedule Area and click Go Live, OR double-click the
image to go live to the audience.

ADD NEW IMAGES
EasyWorship comes with a collection of images ready for you to use in your
presentations. But more than likely you'll want to add new background images that you've
purchased online or produced yourself. Here's how to add new images to your Images
Library.
1. Click the Media tab.
2. Select Images in the Resource Library on the left.
3. In the Images List Area (below Image thumbnails), click the + (Add) icon

.

4. Browse to the image you want to import and select it.
5. Click Open.
6. The imported image appears in the Images List Area.
NOTE:EasyWorship will display .bmp, .jpg, .wmf, png, and .ico files. For the best results,
store all images in Your Profile/images folder. Where is your images folder located? To find
out how to locate your images folder, see Profiles and scroll down to the section titled
"Locate Your Profile Data."

RIGHT-CLICK FEATURES
When you right click on a thumbnail in the Images Resource Library, you have the
following options:
1. Import New Image File...: this is a shortcut to adding additional images.
2. Edit Image Properties...: opens the Image Properties Editor, which allows you to
add a title, control the default aspect ratio for the image, and more.
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3. Copy to Theme >: Select Song Theme, Scripture Theme, or Presentation Theme to
add the image to the desired theme library.
4. Set as Logo Background: sets the image as the default background logo.
5. Delete: deletes the image from the resource area. It will prompt you to delete it
completely from the / Resources / Images folder.
6. View: allows you to change icon size for a custom thumbnail view.
7. Sort by: the same as in Windows.
8. Refresh: the same as in Windows.

DRAG & DROP FEATURES

1. Add to Schedule: Drag and drop an image into the schedule from the Images area.
2. Use as Background: Drag an image onto a song in the schedule to assign that image
to a song as a background.
3. Add a New Image: Drag and Drop images from any folder in Windows to the images
area. EasyWorship will then add a shortcut to that image into your images tab.
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IMAGE PROPERTIES EDITOR
Follow these steps to edit the properties of any image in EasyWorship:
1. Click on the Media tab in the Resource Area.
2. Select Images from the Resource Library on the left.
3. Right-click on any image and select the option to Edit Image Properties.
4. The Image Properties editor will appear, allowing you to customize properties of the
image such as title, aspect ratio, copyright inforomation, tags, etc.

Properties Tab
1. Title: Enter the name of the image in this field.
2. Media Usage:Changes how the background image behaves.
Selecting the Picture icon stretches the image to fill the screen and loops.
Selecting the Movie icon does not stretch the video or image and does not loop if
the background is a video.
3. Aspect Ratio: Allows you to maintain the aspect ratio, stretch, or zoom the image.

Info Tab
1. Title: Enter the name of the image in this field.
2. Author: Enter the Author in this field.
3. ©Button: Enter copyright info in this field. Pressing the copyright logo button adds
the copyright logo to the copyright field.
4. Description: In the drop-down area, enter a description for the image (description
keywords are searchable from the search bar in the Resource Area).
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5. Tags: In the drop-down area, enter tags for the image (tags are searchable from the
search bar in the Resource Area).
6. OK: Saves the Image properties and closed the window.
7. Cancel: Cancels all changes and closes the window without saving.

Back to Top
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INSPECTOR
In This Article:
1. Info
2. Presentation
3. Slide
4. Element
5. Text
6. Media
The inspector is available in the Song Editor, Presentation Editor, Theme Editor, and
Schedule Editor. It allows you to make additional formatting changes to selected
elements.
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INFO

Add or edit information for the song's Title, Author, Copyright, Administrator, and Song
Number. The Title field can also be used to view or change the name of a Presentation or
Theme.
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PRESENTATION

1. Aspect Ratio sets the aspect ratio of the presentation.
2. Loop Presentation sets whether or not the presentation will replay when complete.
3. Presentation Theme allows you to revert the changes made to the default theme
settings.
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SLIDE

The Slide tab allows you to show/hide Theme Elements on your slide. Check the desired
elements.
Advance Slide:
Select On Click to manually control the transitions with the mouse or keyboard.
Select Automatically for an automatic transition.
Selected Delayed if you want the transition to start after a certain period of time.
After sets the length of time to wait before the transition begins.
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The Apply to Theme button applies the changes made in the Inspector to the theme
being used.
The Revert to Theme button reverts the changes made in the Inspector back to the
default theme settings.

Background

None
Color Fill

- 58 -

EasyWorship 6 Manual: Inspector
1. The Color selector lets you choose the background color of the slide.
2. The Opacity slider sets the transparency of the color fill.
Gradient Fill
1. The Style selector provides various gradient styles to select from.
2. Color 1 sets the color for half of the gradient.
3. Color 2 sets the color for half of the gradient.
4. Mirror Colors adds color 1 to each side of color 2.
5. The Angle dial and field allows you to set a specific angle for the gradient.
6. Opacity sets the transparency of the gradient.
Media Fill
1. Select Media allows you to browse and select media that has been added to the
media resources area of EasyWorship.
2. Media Usage changes how the background image behaves.
Selecting the Picture icon
Selecting the Movie icon

stretches the image to fill the screen and loops.
does not stretch the video or image and does not

loop if the background is a video.
3. The Repeating selector determines how a video will behave.
4. Aspect Ratio sets the aspect ratio of the background.
5. Opacity sets the transparency of the background media item.
6. Volume changes the volume of the media item being used as the background.
7. Mute mutes or unmutes the volume of the media item being used as a background.
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8. The Apply to Theme button applies the changes made in the Inspector to the theme
being used.
9. The Revert to Theme button reverts the changes made in the Inspector back to the
default theme settings.

Transition

1. The Transition drop-down allows you to select the transition you wish to use for the
slide.
2. Duration sets the length of the transition from start to finish.
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3. Ease In / Ease Out: Controls whether the transition starts out fast and slows down or
starts out slow and speeds up. If the slider is all the way to the left it will start slow and
end fast. If the slider is all the way to the right it will start the transition fast and end slow.
4. The Options box present available settings for each transition type. For example. some
transitions have the option to start from different directions on the screen.
5. The Apply to Theme button applies the changes made in the Inspector to the theme
being used.
6. The Revert to Theme button reverts the changes made in the Inspector back to the
default theme settings.

ELEMENT
1. Constrain Proportions: Locks the aspect ratio of the selected element so that
when it is resized the aspect ratio maintained.
2. Opacity: Controls the transparency of the selected element.
3. The Apply to Theme button applies the changes made in the Inspector to the theme
being used.
4. The Revert to Theme button reverts the changes made in the Inspector back to the
default theme settings.

Fill
This area of the Inspector gives you control over the background of the selected element.
None
Color Fill
1. The Color selector lets you choose the background color of the slide.
2. The Opacity slider sets the transparency of the color fill.
Gradient Fill
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1. The Style selector provides various gradient styles to select from.
2. Color 1 sets the color for half of the gradient.
3. Color 2 sets the color for half of the gradient.
4. Mirror Colors adds color 1 to each side of color 2.
5. The Angle dial and field allows you to set a specific angle for the gradient.
6. Opacity sets the transparency of the gradient.
Media Fill
1. Select Media allows you to browse and select media that has been added to the
media resources area of EasyWorship.
2. The Media Usage selector stretches the image or video to fit the screen and if the
background is a video, it loops.
3. The Repeating selector determines how a video will behave.
4. Aspect Ratio sets the aspect ratio of the background.
5. Opacity sets the transparency of the background media item.
6. Volume changes the volume of the media item being used as the background.
7. Mute mutes or unmutes the volume of the media item being used as a background.

Border
This area of the Inspector provides the option to turn on borders for the selected element,
change border formatting, and adjust border placement on the edge of the element.
1. Border Style allows you to choose the type of border for the element.
None turns element border on or off.
Outer places the border on the outside edge of the element.
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Center places the border on the center of the edge of the element.
Inner places the border on the inside edge of the element.
2. Color sets the color of the border.
3. Join allows you to choose between Round, Bevel, and Miter joins. This influences
the joins in a border such as a corner.
4. Position allows you to choose Outer, Center and Inner for the location of the border
on the edge of the element.
5. Size sets the thickness of the element border.
6. Opacity sets the transparency of the element border.
7. The Apply to Theme button applies the changes made in the Inspector to the theme
being used.
8. The Revert to Theme button reverts the changes made in the Inspector back to the
default theme settings.

Shadow
1. Shadow Style selects the pre-designed type of shadow to be used.
2. Color changes the color of the shadow.
3. Angle sets the angle of the element shadow.
4. Offset controls the distance of the shadow from the element.
5. Blur allows you to blur the element shadow.
6. Opacity sets transparency of the element shadow.
7. The Apply to Theme button applies the changes made in the Inspector to the theme
being used.
8. The Revert to Theme button reverts the changes made in the Inspector back to the
default theme settings.
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Reflection
1. Reflection Style sets the pre-designed style of reflection for the element.
2. Size modifies the size of the reflection.
3. Distance changes the distance between the element and its reflection.
4. Opacity controls the transparency of the element reflection.
5. The Apply to Theme button applies the changes made in the Inspector to the theme
being used.
6. The Revert to Theme button reverts the changes made in the Inspector back to the
default theme settings.

- 64 -

EasyWorship 6 Manual: Inspector

TEXT

Back to Top

Text Attributes
1. Margins: Left, Right, Top, and Bottom margin settings
2. Vertical Align allows you to change the vertical alignment of the text.
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3. Auto Sizing:
Do not auto size text turns auto-sizing off.
Resize text to fit element turns auto-sizing on. Check the Normalize text size
across slides box if you want EasyWorship to automatically make text on all
slides the same size.
4. Formatting
Word wrapping turns automatic word wrapping on/off.
Capitalize all words automatically makes all words appear in all caps.
Capitalize first word of each line automatically capitalizes the first character
of each line.

Font
1. Font Name allows you to select a font style from the drop-down.
2. Size sets the font point size.
3. Color changes the color of the text.
4. Style allows you to select Regular, Bold, Italic or Bold Italic.
5. Underline turns underline on or off.
6. Superscript turns superscript on or off.
7. Subscript turns Subscript on or off.
8. Opacity sets transparency of the text.
9. Alignment allows you to set the horizontal alignment of the text.

Outline
1. The Style drop-down allows you to choose None, Outer, Center, and Inner for the
location of the outline on the edge of the text.
2. Color changes the color of the text outline.
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3. Join allows you to choose between Round, Bevel, and Miter joins. This influences
the joins in an outline such as a corner.
4. Size sets the thickness of the text outline.
5. Opacity sets transparency of the text outline.

Shadow
1. Style turns text shadow on or off.
2. Color changes the color of the text shadow.
3. Angle sets the angle of the text shadow.
4. Offset controls the distance of the shadow from the text.
5. Blur allows you to blur the text shadow.
6. Opacity sets transparency of the text shadow.

Bullets
1. Indent Level sets the indent for bullets.
2. Bullets selects between Bullets or Numbers, and reveals options for selecting the
bullet or number style.
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MEDIA

1. Name: The name of the media element selected.
2. Media Usage changes how the background image behaves.
Selecting the Picture icon
Selecting the Movie icon

stretches the image to fill the screen and loops.
does not stretch the video or image and does not

loop if the background is a video.
3. Aspect Ratio sets the aspect ratio of the background.
4. Opacity sets the transparency of the background media item.
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5. Volume changes the volume of the media item being used as the background.
6. Mute: Mutes or unmutes the volume of the media item being used as a background.
7. The Apply to Theme button applies the changes made in the Inspector to the
theme being used.
8. The Revert to Theme button reverts the changes made in the Inspector back to the
default theme settings.

Back to Top
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OPTIONS
In This Article:
1. Live
2. > Song
3. > Scripture
4. > Presentation
5. > Alerts
6. Foldback
7. Advanced
8. Transitions
To access the Options menu in EasyWorship, click Edit in the main menu, then click
Options.
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LIVE
Select Output Monitor
This is where you can setup how and where EasyWorship sends its output to the
audience.
1. Output Monitor : This drop-down button allows you to set the screen or location you
wish to send the EasyWorship output to.
2. Output Format: Allows you to select the format you wish to send to the NewTek
Tricaster over your local network connection. This option is only available when
selecting the NewTek AirSend option from the Output Monitor drop-down.
3. Output Position: Shows you where EasyWorship is sending its output to by pixel
location. If custom position is select from the Output Monitor drop down, you will enter
the location you want EasyWorship to send its output to in these fields.
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4. Alpha Channel: This drop-down button allows you to select which output to send
alpha channel content to. This option is not available if you have selected the
NewTek AirSend output from the Output Monitor drop-down.
5. Monitor Setup Button: Opens the Windows Display Settings window to allow you to
extend your windows Desktop to another screen or change other display settings
without having to close EasyWorship.

Screen Margins
This area allows you to customize the screen margins, i.e., fine-tuning the placement of
EasyWorship content on the output screen.
1. Left: Left margin setting.
2. Right: Right margin setting.
3. Top: Top margin setting.
4. Bottom: Bottom margin setting.

Default Font
When you click the Default Font drop-down, the following window appears, allowing you
to set the default appearance of the text.
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1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
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5. Formatting Tab: This tab allows you to customize song text formatting.
Auto Sizing - select "Do not auto size text" if you want to turn auto sizing off,
or select "Resize text to fit element" to turn auto sizing on (check the box next
to "Normalize text size across slides" if you want EasyWorship to
automatically make text on all slides the same size).
Word Wrapping - check this box to turn automatic word wrapping on.
Capitalize all words - check this box to automatically make all words appear
in call caps.
Capitalize first word of each line - check this box to automatically capitalize
the first word of each line in a song.
Automatically capitalize the first character of these words - check this box to
automatically capitalize the first character of the words listed below when
they are used in a title slide.
Back to Top

SONG
This area of the Options menu allows you to change the default settings for songs, i.e., the
look and feel of song text and margins being displayed to your audience.
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Song Font Button
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
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5. Formatting Tab: This tab allows you to customize song text formatting.
Auto Sizing - select "Do not auto size text" if you want to turn auto sizing off,
or select "Resize text to fit element" to turn auto sizing on (check the box next
to "Normalize text size across slides" if you want EasyWorship to
automatically make text on all slides the same size).
Word Wrapping - check this box to turn automatic word wrapping on.
Capitalize all words - check this box to automatically make all words appear
in call caps.
Capitalize first word of each line - check this box to automatically capitalize
the first word of each line in a song.

Label Font Button
To the left of the Label Font Button is a checkbox that says Show Verse/Chorus Label.
Checking this box tells EasyWorship to display labels that have been entered into your
song, e.g., Verse, Chorus, Bridge, etc.
1. Font Tab: this tab allows you to select the default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off , and set the Opacity
(transparency) and alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Labels Button
This option allows you to set the color coding of your choice for labels and set custom
shortcut keys for each type of label. You can also add new labels if the desired label does
not exist.
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Copyright Info Button
To the left of the Copyright Info Button is a checkbox that says Display Copyright
Information. Checking this box tells EasyWorship to display Copyright info on song
slides when displaying to the audience.
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
The License Info field allows you to enter your CCLI or other copyright license number to
be displayed on songs that require copyright information to be displayed.

SCRIPTURE
This area of the Options menu allows you to enable/disable support for displaying
scriptures (turns EasyWorship's Scripture tab on/off) and customize the default settings
for scriptures, i.e., the look and feel of scripture text and margins being displayed to your
audience.
At the top of the Scripture Attributes area is a checkbox that says Enable support for
displaying scriptures. Checking this box tells EasyWorship to enable support for
displaying scriptures (turns EasyWorship's Scripture tab on).
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Scripture Font Button
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
Back to Top

Verse Font Button
To the left of the Verse Font Button is a checkbox that says Show verse numbers.
Checking this box tells EasyWorship to enable verse numbering in the scripture text.
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
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Reference Font
To the left of the Reference Font Button is a checkbox that says Show Reference.
Checking this box tells EasyWorship to show the scripture reference on the output screen.
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Other Reference & Scripture Options
1. Reference Location allows you to place the scripture reference Before Each Slide,
After Each Slide or After Each Passage
2. Show Complete Passage: when this box is checked, the complete scripture passage
reference will be visible on every slide instead of showing the reference for only the
passages on the current slide being displayed
3. Reference Indent: when this box is checked, EasyWorship indents the scripture
reference.
4. Abbreviated Book Names: when this box is checked, EasyWorship will abbreviate
the book name in the scripture reference when this option is checked.
5. Break on new verse: when this box is check, this option tells EasyWorship to create a
new slide for every verse.
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6. Minimum font size before breaking slide: this option allows you to set a limit on how
small the text in a scripture slide can appear before creating a new slide.

PRESENTATION
This area of the Options menu allows you to customize the default fonts for the Title,
Subtitle, and Content slides in your Presentations, i.e., the default look and feel for fonts in
the Presentation slides you create under the Presentations Tab in EasyWorship.

Title Font Button
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
5. Formatting Tab: This tab allows you to customize song text formatting.
Auto Sizing - select "Do not auto size text" if you want to turn auto sizing off,
or select "Resize text to fit element" to turn auto sizing on (check the box next
to "Normalize text size across slides" if you want EasyWorship to
automatically make text on all slides the same size).
Word Wrapping - check this box to turn automatic word wrapping on.
Capitalize all words - check this box to automatically make all words appear
in call caps.
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Capitalize first word of each line - check this box to automatically capitalize
the first word of each line in a song.
Automatically capitalize the first character of these words - check this box to
automatically capitalize the first character of the words listed below when
they are used in a title slide.

SubTitle Font Button
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
5. Formatting Tab: This tab allows you to customize song text formatting.
Auto Sizing - select "Do not auto size text" if you want to turn auto sizing off,
or select "Resize text to fit element" to turn auto sizing on (check the box next
to "Normalize text size across slides" if you want EasyWorship to
automatically make text on all slides the same size).
Word Wrapping - check this box to turn automatic word wrapping on.
Capitalize all words - check this box to automatically make all words appear
in call caps.
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Capitalize first word of each line - check this box to automatically capitalize
the first word of each line in a song.
Automatically capitalize the first character of these words - check this box to
automatically capitalize the first character of the words listed below when
they are used in a title slide.

Content Font Button
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
5. Formatting Tab: This tab allows you to customize song text formatting.
Auto Sizing - select "Do not auto size text" if you want to turn auto sizing off,
or select "Resize text to fit element" to turn auto sizing on (check the box next
to "Normalize text size across slides" if you want EasyWorship to
automatically make text on all slides the same size).
Word Wrapping - check this box to turn automatic word wrapping on.
Capitalize all words - check this box to automatically make all words appear
in call caps.
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Capitalize first word of each line - check this box to automatically capitalize
the first word of each line in a song.
Automatically capitalize the first character of these words - check this box to
automatically capitalize the first character of the words listed below when
they are used in a title slide.
Back to Top

ALERTS

The Alerts tab allows you to set options for the Nursery Alerts that appear on screen.
1. Check Enable Nursery Alert to turn allow nursery alerts.
2. Click Nursery Font to set the default font settings for the nursery alerts.
3. Set the Background Color, Background Opacity, and Screen Location as
desired.
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4. To Automatically Remove the alert after a set amount of time, click the checkbox
and enter the desired time limit.

FOLDBACK
At the top of the Foldback Options area is a checkbox that says Enable support for
display Foldback (stage display). Checking this box allows EasyWorship to take
advantage of a third video output to display content for stage monitors.

Select Output Monitor
Here you’ll find all of the settings needed to setup how and where EasyWorship sends its
output to the display foldback.
1. Output Monitor: This drop-down allows you to set the screen or location to which the
EasyWorship output foldback content will be sent.
2. Custom Position: These fields show you where EasyWorship is sending its foldback
content to by pixel location. If custom position is selected from the Output Monitor
drop down, this is where you will enter the location you want EasyWorship to send its
output to.
3. Screen Margins: These fields allow you to fine-tune the Left, Right, Top, and Bottom
screen margins so EasyWorship's content displays properly on the foldback screen.
4. Default Font: This menu allows you to set the default appearance of the text.
Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
Font Tab: This tab allows you to select a default font style and size, change the
color and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
Outline Tab: This tab allows you to turn text outline on/off, change the color of the
text outline, choose between Round, Bevel, or Miter joins (influences joins in an
outline, such as a corner), choose the location of the outline on the edge of the text
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(Outer, Center, or Inner), and set the thickness and opacity (transparency) of the
text outline.
Shadow Tab: This tab allows you to turn text shadow on/off, change the color,
angle, and offset (distance) of the text shadow, and set the blur and opacity
(transparency) for the text shadow.
Formatting Tab : This tab allows you to customize song text formatting.
Auto Sizing - select "Do not auto size text" if you want to turn auto sizing
off, or select "Resize text to fit element" to turn auto sizing on (check the
box next to "Normalize text size across slides" if you want EasyWorship to
automatically make text on all slides the same size).
Word Wrapping - check this box to turn automatic word wrapping on.
Capitalize all words - check this box to automatically make all words
appear in call caps.
Capitalize first word of each line - check this box to automatically
capitalize the first word of each line in a song.
Automatically capitalize the first character of these words - check this box
to automatically capitalize the first character of the words listed below
when they are used in a title slide.

SONG
The Song Attributes window allows you to change the default settings for songs, i.e., the
look and feel of song text and margins being displayed to your audience.

Song Font Button
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
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2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
5. Formatting Tab: This tab allows you to customize song text formatting.
Auto Sizing - select "Do not auto size text" if you want to turn auto sizing off,
or select "Resize text to fit element" to turn auto sizing on (check the box next
to "Normalize text size across slides" if you want EasyWorship to
automatically make text on all slides the same size).
Word Wrapping - check this box to turn automatic word wrapping on.
Capitalize all words - check this box to automatically make all words appear
in call caps.
Capitalize first word of each line - check this box to automatically capitalize
the first word of each line in a song.
Automatically capitalize the first character of these words - check this box to
automatically capitalize the first character of the words listed below when
they are used in a title slide.

Label Font Button
To the left of the Label Font Button is a checkbox that says Show Verse/Chorus Label.
Checking this box tells EasyWorship to display labels that have been entered into your
song, e.g., Verse, Chorus, Bridge, etc.
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1. Font Tab: this tab allows you to select the default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off , and set the Opacity
(transparency) and alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

SCRIPTURE
The Scripture Attributes window allows you to enable/disable support for displaying
scriptures (turns EasyWorship's Scripture tab on/off) and customize the default settings
for scriptures, i.e., the look and feel of scripture text and margins being displayed to your
audience.
At the top of the Scripture Attributes area is a checkbox that says Enable support for
displaying scriptures. Checking this box tells EasyWorship to enable support for
displaying scriptures (turns EasyWorship's Scripture tab on).

Scripture Font Button
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
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3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
Back to Top

Verse Font Button
To the left of the Verse Font Button is a checkbox that says Show verse numbers.
Checking this box tells EasyWorship to enable verse numbering in the scripture text.
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Reference Font
To the left of the Reference Font Button is a checkbox that says Show Reference.
Checking this box tells EasyWorship to show the scripture reference on the output screen.
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.

- 88 -

EasyWorship 6 Manual: Options
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.

Other Reference & Scripture Options
1. Reference Location allows you to place the scripture reference Before Each Slide,
After Each Slide or After Each Passage
2. Reference Indent: when this box is checked, EasyWorship indents the scripture
reference.

MISCELLANEOUS
The Miscellaneous Options area allows you to enable/disable and customize Clock
Options and Next Item Information, i.e., an abbreviated preview on the bottom of the
display Foldback monitor of what's coming up on the next slide.

Clock Options
To the left of the Clock Font button is a checkbox that says Enable foldback clock.
Checking this box enables the Clock Options.
Clock Font

1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
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such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
4. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
5. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
Background Color and Clock Location

You can also set the desired background color and the location of the clock in the slide.

Next Item Info Button
To the left of the Next Item Font button is a checkbox that says Enable next item info.
Checking this box enables Next Item Information. Next item info can show up either 1)
as the first line of the next slide, or 2) as the title of the next item in the schedule.
1. Font Tab: This tab allows you to select a default font style and size, change the color
and style of the text, turn Superscript and Subscript on/off, set the opacity
(transparency) of the text, and set the horizontal and vertical alignment of the text.
2. Outline Tab: This tab allows you to turn text outline on/off, change the color of the text
outline, choose between Round, Bevel, or Miter joins (influences joins in an outline,
such as a corner), choose the location of the outline on the edge of the text (Outer,
Center, or Inner), and set the thickness and opacity (transparency) of the text outline.
3. Shadow Tab: This tab allows you to turn text shadow on/off, change the color, angle,
and offset (distance) of the text shadow, and set the blur and opacity (transparency)
for the text shadow.
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4. Margins Tab: This tab allows you to set the Left, Right, Top, and Bottom margin
settings.
Additionally, you can set the background color of the Next Item.

Transitions
This area allows you to determine the default styles for slide to slide transitions, as well as
Black, Clear, and Logo transitions (Black, Clear, and Logo buttons are on the right side of
EasyWorship's main toolbar).
1. Slide Transition: Sets the transition between schedule items and between slides in a
song, scripture, or presentation.
2. Black Transition: Sets the transition for the Black and un-Black transition.
3. Clear Transition: Sets the transition for the Clear and un-Clear transition.
4. Logo Transition: Sets the transition for the Logo and un-Logo transition.

ADVANCED
Live Options
1. Show live screen on startup: When checked, this options tells EasyWorship to
display the last used background on the output screen immediately after the program
has launched.
2. Advance Schedule after Go Live is pressed: When this box is checked, EasyWorship
automatically selects the next item in the scheduled when the Go Live button is
clicked. For example, the first item in your schedule is a mini-movie and the second
item is a song. When you select the first item and click Go Live, the mini-movie plays
and the song is automatically selected and ready to Go Live as soon as the minimovie ends. All you need to do is click Go Live again to send the song to the
audience.

- 91 -

EasyWorship 6 Manual: Options

PowerPoint Options
1. Use PowerPoint Viewer instead of Full PowerPoint Application: When this box is
checked,EasyWorship will load the PowerPoint Viewer to display PowerPoint slide
shows.
PLEASE NOTE: USING THE VIEWER IS AN UNSUPPORTED FEATURE
AND MAY RESULT IN EMPTY POWERPOINT THUMBNAILS ON SOME
VIDEO CARDS.

DVD Options
1. Use preferred DVD video codecs: When this box is checked, EasyWorship will look
for and use DScaler if it is available (EasyWorship ignores other decoders if the
DScaler codec is available).
2. Prevent DVD spin down: When checked, this keeps the DVD in the drive spinning at
all times to reduce the amount of time needed to send a DVD clip to the screen.

Video Card Options
1. Disable GPU Shrink Filter: Only select this if you are only seeing a solid color on the
output screen. This option should only be used to troubleshoot rendering issues with
your video card.

PREVIEW OUTPUT
In the bottom let corner of the Options window, there is a checkbox next to Preview
Output. Use this option to view changes on the output screen as you make them.

Back to Top
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PRESENTATION EDITOR
EasyWorship's robust Presentation Editor is a full slide designer. Choose from different
types of slides, control transitions, create slide loops, and create/apply custom themes.
When you edit a presentation in a Schedule, you can choose to make changes that affect
the presentation for that schedule only, or you can make permanent changes to a
presentation in the Resource Area under the Presentations tab.

EDIT A PRESENTATION IN THE SCHEDULE
1. In the Schedule Area, select the presentation to be edited.
2. Right-click on the presentation.
3. Click on Edit Item....
4. The Schedule Editor window appears.
5. The Words tab or Slides tab can be used to enter or edit text as needed.
6. Use the toolbar to change the font and edit its style, size, and alignment.
7. Use the heading buttons to select a Theme, create a new Text box, add a Scripture
or Media element or Background, or Arrange Elements.
8. Use the Inspector button to customize your presentation any way you want.

Add a new slide
1. Click the + (Add) icon in the bottom left corner to create a new slide, and then type
the new slide text.
2. Click OK when you are satisfied with the presentation.
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EDIT A PRESENTATION IN THE DATABASE
1. In the Resource Area, click on the Presentations tab.
2. Select the presentation you wish to edit.
3. Right-click on the presentation.
4. Click Edit Presentation.... The Presentation Editor appears.
5. The Words tab or Slides tab can be used to enter or edit text as needed.
6. Use the toolbar to change the font and edit its style, size, and alignment.
7. Use the heading buttons to select a Theme, create a new Text box, add a Scripture
or Media element or Background, or Arrange Elements.
8. Use the Inspector button to customize your presentation any way you want.

Back to Top
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SCRIPTURES
1. Add a Scripture to the Schedule
2. Quick Search
3. Adding Consecutive Scriptures
4. Scripture Reflow
5. Using Scripture on the Fly
In this article, you'll learn how to add, edit, and delete Scriptures in your EasyWorship
Schedule. You'll also learn about Search functions that are new to EasyWorship, making
it easier than ever to find, customize, and present Scriptures to your audience.

ADD A SCRIPTURE TO THE SCHEDULE
1. Click the Scriptures tab in the Resource Area.
2. Select a version of the Bible from the Resource Library on the left.
3. To search the Scriptures by reference, click on the icon in the Search field above the
bible list. When it looks like a line list , it's set to search by reference.
4. Type your reference in the search box above the Resource Area.
5. Drag-and-drop the selected scripture to the Schedule Area.
6. To search the Scriptures by keyword, click on the icon in the Search field above the
Resource Area. When it looks like a magnifying glass , it's set to contextual
search (i.e., keyword).
7. Type in any word or phrase to find what you’re looking for.
8. Drag-and-drop or double-click the selected scripture to add it to the Schedule.
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Quick Search
For a reference search such as 1 Thessalonians 1:3:
1. In the search box, type "1 The". EasyWorship will then auto-complete the book name
for you as 1 Thessalonians.
2. Press the Spacebar, then type in the chapter, 1.
3. Press the Spacebar, then type in the verse, 3.

Contextual Search
For a contextual search, like the word "hope":

1. To search the Scriptures by keyword, click the Search icon above the bible list.
When it looks like a magnifying glass , it's set to contextual search (i.e., keyword).
2. Type in the word hope.
3. Every verse in the bible with the word "hope" will be listed.

Adding Consecutive Scriptures
For consecutive verses:
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1. You may want to add consecutive verses to the schedule at one time, such as John
1:1-15. Under the Scriptures Tab in the Resource Area, select the version of the
Bible you would like to use from the Resource Library on the left.
2. To search the Scriptures by keyword, click the Search icon above the bible list.
When it looks like a line list , it's set to search by reference.
3. Type your scripture range in the Search field (e.g., John 1:1-15). The scriptures are
automatically highlighted below in the Resource List.
4. Drag-and-drop the selected block of verses to the Schedule Area.
5. You may also type a single scripture in the Search field (e.g., John 1:1). This search
will return and ordered list of verses. You can then click the first verse, hold down the
Shift key on the keyboard, click on the last verse in the range of verses you want to
include, then drag-and-drop the selected block of verses to the Schedule Area.
6. By default, EasyWorship will reflow the text to a new slide when the maximum text
area is filled.

Adding Multiple Non-Consecutive Verses
1. You may want to use multiple non-consecutive scriptures such as Genesis 1:1, 5, 7, 8
and 12. Under the Scriptures Tab in the Resource Area, select the version of the
Bible you would like to use from the Resource Library on the left.
2. Search for and click on your desired scripture (e.g., Genesis 1:1), then hold down the
Ctrl key on the keyboard and click each verse you want to display.
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3. Drag-and-drop the selected verses to the Schedule Area.
4. EasyWorship will separate each verse into its own slide.

Scripture Reflow
Here's how to change the default Scripture Reflow setting so EasyWorship will create a
new slide for each verse.
1. Click the Edit menu, then select Options.
2. Under Live, select Scripture.
3. Check the option to Break on new verse.
4. Click OK.
Back to Top

USING SCRIPTURE ON THE FLY
Single Verse
1. Click the Scriptures tab in the Resource Area.
2. Select the Bible version you want to use from the Resource Library on the left.
3. Type the scripture reference in the Search field above the Resource Area.
4. Double-click the selected scripture to make it Go Live.

Multiple Verses
1. Click on the Scriptures tab in the Resource Area.
2. Select the Bible version you want to use from the Resource Library on the left.
3. Type the scripture reference in the Search field above the Resource Area.
4. Hold down the Shift key on the keyboard, then use your mouse to click consecutive
verses, OR hold down the Ctrl key on the keyboard and use your mouse to click

- 98 -

EasyWorship 6 Manual: Scriptures
multiple non-consecutive verses. Once the verses have been highlighted, click the
Play button next to the Search field to make your selection Go Live.

Editing Scriptures
1. Drag-and-drop a scripture to the Schedule Area.
2. Right-click on the scripture in the Schedule.
3. Click on Edit Item.
4. In the Schedule Editor, make any needed changes (editing scripture is the same
process as editing a song in the Schedule). For more information on formatting
scripture text, see "Edit a Song in the Schedule" in Songs.

Back to Top
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SONGS
In This Article:
1. Add a Song
2. Type a Song
3. Edit a Song
4. Delete a Song
5. Customize Song Slides
6. Import a Song or Text
7. Locate and Display a Song
In this article, you'll learn how to add, edit, and delete songs in EasyWorship, how to
customize song slides (backgrounds, custom labels, additional text fields), how to import
songs from Song Select Lyric Service or an existing EasyWorship database, and how to
locate and display a song to the audience.

ADD A SONG
The EasyWorship Song Editor allows you to add a new song to the songs resource area
database by typing it, by importing it, or by copy and paste.
1. Click the + icon button at the bottom of the song list, or right-click any song under the
Songs tab in the Resource Area, and select New Song.
2. The Song Editor appears.
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TYPE A SONG
1. Type a name for the song in the Title box.
2. Type the label you want to use for the slide under the Words tab. (e.g., Verse 1,
Chorus, Intro).
3. Type the lyrics for the song in the Words tab.
4. To create a new slide, either press Ctrl+Enter after typing the slide text or click the
Add icon at the bottom left corner of the Words tab.

EDIT A SONG
The EasyWorship Song Editor allows you to edit songs, miscellaneous text, and song
information. When editing a song, you can choose either to save your edits to the song in
the current schedule only, or to save your edits to the song permanently in the song
Resource Area.

Edit a Song in the Schedule
1. In the Schedule area, select the song to be edited.
2. Right-click on the song and select Edit Item....
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3. The Schedule Editor window appears.
4. The Words tab or Slides tab can be used to enter or edit text as needed.
5. Use the toolbar to change the font and size of the text, the style, and the alignment.
6. Use the header buttons to select a Theme, create a new Text box, add a Scripture,
add a Media element, or Arrange Elements (See Customize Song Slides).
7. Use the Inspector button to customize your song any way you want.

Edit a Song in the Database
1. In the Resource Area, click on the Songs tab.
2. Select the song you wish to edit.
3. Right-click on the song and select Edit Song.
4. The Words tab or Slides tab can be used to enter or edit text as needed.
5. Use the toolbar to change the font and size of the text, the style, and the alignment.
6. Use the header buttons to select a Theme, create a new Text box, add a Scripture or
Media element or Background, or Arrange Elements.
7. Use the Inspector button to customize your song any way you want.

Edit Song Copyright Information
The CCLI # appears by default when a song is copyrighted, or you can add the copyright
symbol and date to the Inspector in the Song Editor. Once you have entered the CCLI #, it
will automatically appear in each copyrighted song. To add/edit the CCLI #, follow these
steps:
1. Click on the Songs tab in the Resource Area.
2. Right-click on the song and select Edit Song.
3. Click the Inspector button in the top-right corner of the Song Editor window to
display the Song Information.
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4. Edit the desired information and close the Inspector window.
5. In the Song Editor, click OK to save your changes.

DELETE A SONG
Remove a Song from the Schedule
1. In the Schedule area, locate the song you would like to remove.
2. Right-click and select Remove From Schedule from the pop out menu.
3. You will get a confirmation asking if you’re sure you want to delete this schedule item.
4. Click Yes to remove this song from the schedule.

Delete a Song from the Database
WARNING: The following procedure permanently deletes the selected song from the
EasyWorship Songs database.

1. In the Resource Area, locate the song you would like to delete.
2. Right-click on that song and select Delete.
3. You will get a confirmation asking if you’re sure you want to permanently delete this
song.
4. Click Yes to permanently delete the song from the songs database.
Back to Top

CUSTOMIZE SONG SLIDES
You can also select a Theme, create a text box, add Scripture or Media, and use the
Arrange and Inspector buttons on the toolbar to format your new song.
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Select a Theme
Click the Theme button on the toolbar and select the desired Theme you would like to
use for that song.

Add Another Text Box
Click the Text button on the toolbar to add another text box to the current slide.

Add a New Slide
Click the + icon in the bottom left corner to create a new slide, and then type the new slide
text.

Splitting Slides
If you need to split an existing slide into two or more slides, move the cursor to the
beginning of the line you wish to be the first line of the new slide and press Ctrl+Enter on
the keyboard.

Insert Labels
1. When a new slide is added, there are two field options. One for Label and one for
Song. Click where it shows label and type in your label. i.e., Verse1 or Chorus
2. Then press Enter to type the new song text.
3. Click OK when you are satisfied with the song.

Add Scripture to Current Slide
1. Click the Scripture button on the toolbar.
2. Select the translation you would like to use.
3. Search for the scripture you would like to use.
4. Either double-click the verse(s) or drag and drop the verse(s) to add the scripture to
the current slide.
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5. The scripture will be added in its own text box that you can resize and move if
needed.

Add Media
Add Media as a background for the whole song:
1. Click the Inspector button on the toolbar.
2. Click Background.
3. Select your Fill Style.
4. For each respective style, choose all the options you want to use.
5. Click the Apply to Theme button at the bottom.
Adding media as a background for a single slide:
1. Click the Slides tab in the upper-left of the Song Editor.
2. Click the Media button on the toolbar.
3. Select the type of media you want to use from the drop-down (Videos, Images,
Feeds, DVDs, Audio).
4. Drag-and-drop the desired media file to your desired slide under the Slides tab on
the left.
Adding Media as an element to the current slide:
1. Click the Slides tab in the upper-left of the Song Editor.
2. Click the Media button on the toolbar.
3. Select the type of media you want to use from the drop-down (Videos, Images,
Feeds, DVDs, Audio).
4. Double-click the desired media file (you can also drag-and-drop the media file to the
selected slide directly below the Media tab).
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5. Resize and move the element to your desired location on the slide.
6. You can select the element and arrange it to the front or back by clicking on the
Arrange button on the toolbar.
7. Click OK when you are satisfied with the song.
Back to Top

IMPORT A SONG OR TEXT
Import a song from document
1. Open EasyWorship, Click the + icon at the bottom of the song list to create a new
song.
2. Click the Import icon to the left of the printer icon at the top of the editor. The
Windows Open dialog box appears allowing you to locate the desired file.
3. Click OK when you have located the file. The song or text appears in the text box
where you can edit and format it.

Import a song from SongSelect Lyric Service
CCLI’s™ SongSelect Lyric Service allows you to download songs from thousands of
songs on their web site for a nominal monthly/yearly fee. This Lyric Service is provided by
Christian Copyright License International. To use the CCLI's™ SongSelect Lyric Service,
you must be a member with a valid User ID and Password. If you are not a current
member, you can subscribe to this service at ccli.com.
1. Click the Web button on the toolbar.
2. Click SongSelect tab at the top.
3. Sign in to your SongSelect account.
4. Search the song you would like to import.
5. Click to view the Lyrics page for that song.
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6. In the upper-right corner, click the Import button and the song will be added to your
song database.
7. If you want the song to be added to the Schedule from that page, click the Schedule
button at the top right.
8. To make any changes to the song, right-click the song in the database and select
Edit Song. For help editing songs, go to Edit a Song.
9. To close out of the Web, click the Web button on the toolbar again or click the Close
button at the top right.
NOTE: You must be connected to the Internet to download a song from CCLI's™
SongSelect Lyric Service.

Copy / Paste
1. Type a name for the song in the Title box.
2. Type the label you want to use for the slide under the Words tab. (i.e., Verse 1,
Chorus, Intro).
3. Paste in the text you copied from another source (Word, Notepad, website).
NOTE: If you have made changes to the attributes of the song and you want to change it
back to the default, click the Reset to Default button. If you delete or change the actual text,
you can use Ctrl-z to undo the changes.

Back to Top

LOCATE AND DISPLAY A SONG
1. In the Resource Area, click the Songs tab.
2. Type the name of the song in the search box for a Title search, or change to a
Contextual search and search by keyword (e.g., popular phrase in the lyrics).
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3. If you are doing a Title Search, you can begin typing and EasyWorship will autocomplete the text with the best match alphabetically.
4. After you locate the song, drag-and-drop it from the Resource Area to the
Schedule Area.
5. OR select the song in the database and click Go Live, or double-click the song to
send it directly to the Live Output Area.
6. Click on each verse in the Live Area and follow your leader, OR use the UP and
DOWN arrows to advance to the next slide.
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THEMES
In this article:
1. Overview
2. Theme Editor
3. Creating A Theme
4. Using Themes

OVERVIEW
Themes are simply design templates that can be applied to songs, scriptures, and
presentations. How does this make your life easier? Once you've taken the time to design
a Theme by customizing your text format, background, and layout just the way you want, it
can then be applied to any song, scripture, or presentation in your Schedule Area in
seconds. Just save your new Theme to your Theme Library, then drag-and-drop it on top
of a song, scripture, or presentation in your Schedule. You can also select and apply it
using the Theme button in any one of the Song, Scripture, or Presentation Editors.

CREATING A THEME
It's quick and easy to build a theme in EasyWorship using the Theme Editor. To get
started, click the Themes tab in the Resource Area, select the type of theme you want to
create (Song, Scripture, or Presentation), and then click the + (Add) button at the
bottom of the Themes Area. You may also create a theme by selecting one or more media
items, right-clicking on the selected media item(s), and selecting copy to Song, Scripture
or Presentation Theme. This will place the media item in the themes area allowing you to
use it as the default theme (a.k.a., background) or drag-and-drop to a song in the
schedule or select it from the themes drop-down in the song or presentation editor.
NOTE: The theme editor is similar to the Song and Presentation Editors in that it has slides,
an Inspector, and it allows you to add media and text boxes to slides. However, unlike the
Song and Presentation Editors, the Theme Editor does not allow you to add or change text on
the slides. The Theme Editor is designed for making overall formatting and placement
changes, not changes to the text or other content on the slides.
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THEME EDITOR

1. Title: Enter the name of the theme in this field.
2. Text: Adds a text box that you can type text in to display on each slide.
3. Scripture: Clicking the scripture button allows you to select scripture text and press
enter or drag it to add it to the theme.
4. Media: Clicking the media button allows you to select videos, images, feeds, DVD
clips or audio and press enter or drag it to add it to the theme.
5. Arrange: Clicking this button allows you to set the layer at which the selected
element resides. You have the option of Move Up, Move Down, Bring to Front, Send
to Back.
6. Inspector: Opens the inspector window. The Inspector allows you to make more
detailed formatting changes to different elements in the theme.
7. Import: Allows you to import a text document into your song, presentation or theme.
8. Print: Allows you to print the theme.
9. Spell Check: Checks spelling and allows you to make spelling changes or add
words to the dictionary.
10. Font Selector: Clicking the font selector allows you to select the font formatting you
wish to use on selected text.
11. Auto Sizing Drop-Down: Allows you to choose between setting an exact font size
or automatically sizing the font.
12. Font Size: Changes the font size of the text to the point size selected.
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13. Font Color: Allows you to change the color of selected text by selecting from the
color palette provided.
14. Text Style Options: Bold, Italics, Underline, Shadow, Outline
15. Horizontal Alignment Options: Left Align, Center Align, Right Align
16. Vertical Alignment Options: Top Align, Middle Align, Bottom Align
17. Indent / Outdent: Increase or decrease the indent level of the paragraph.
18. Reset to Default: Resets formatting to default settings.

USING THEMES
Presentation Themes
When you add a Presentation Theme, you'll notice that it has more default slides than a
Song or Scripture Theme. That's because a Presentation Theme has many different
types of content slides that can be added to it (e.g., Title Slide, Title and Content Slide,
Content Only Slide, Blank Slide, and Scripture Slide).

Theme Button
When editing a song, scripture, or presentation, in the Editor's main toolbar you'll see a
Theme drop-down button. Click this button and select an existing theme to apply its
layout and formatting to the song, scripture or presentation you're working on. You may
also drag and drop a theme onto a song, scripture or presentation in the schedule from the
Themes Area.
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Back to Top
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VIDEOS
1. Adding Videos
2. Adding Videos from the Media Store in EasyWorship
3. Playing Videos
4. Deleting Videos
5. Using Videos in Presentations and Songs
6. Video Properties Editor
EasyWorship allows you to use videos as an individual schedule item, as a background, or
as an element in a presentation. The following steps will show you how to add videos to
the EasyWorship media area and how to use them.

ADDING VIDEOS
EasyWorship can import videos that you have produced, or additional videos you have
purchased.

In the Resource Area
1. Click the Media tab.
2. Click the Videos tab.
3. Click the Add button at the bottom of the video resource list to access the Add
Videos dialog box.
4. Locate and highlight the video or videos that you want to import.
5. Click Open.
NOTE: You can drag-and-drop a video from Windows File Explorer or the desktop into the
videos Resource Area.
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ADDING VIDEOS FROM THE MEDIA STORE IN EASYWORSHIP
For information on downloading and installing free / sample media from the media store,
see Downloading Free Media.
1. To purchase videos from the media store, log into your account and search for a
video.
2. Once a desired video is located, click Buy Now. The Checkout / Payment
Information window appears.
3. Enter the appropriate payment information and click Place Order.

PLAYING VIDEOS
1. In the Resource area, click the Media tab.
2. Select Videos from the Resource Library on the left.
3. Drag and drop a video to the Schedule Area.
4. Select that video in the schedule and click the Go Live button.
5. You may also select a video in the Resource Area and click Go Live.

DELETING VIDEOS
In the Resource Area
1. Click the Media tab.
2. Right click the video that you want to delete.
3. Click Delete.
4. A message appears asking if you want to permanently delete the video.
5. Click Yes to delete the video.
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Drag-and-Drop Features
1. Add to Schedule: Drag and drop a video into the schedule from the Images tab.
2. Use as Background: Drag a video onto a song in the Schedule to assign that image
to a song as a background.
3. Add a New Video: Drag and Drop a video from any folder in Windows to the videos
area.

USING VIDEOS IN PRESENTATIONS AND SONGS
When creating or editing a presentation or song, you can access videos from the media
drop-down. You can drag and drop videos on to slides as an element or drag it to a slide in
the Schedule Area to make it a background for that slide.

In the Inspector
1. Click Background under Slide.
2. Change the Fill Style to Media Fill.
3. Click the drop-down next to Select Media to select the video you wish to use as the
background.
4. Click Apply to Theme to set the background for all slides.
Back to Top

VIDEO PROPERTIES EDITOR
Follow these steps to edit the properties of any video in EasyWorship:
1. Click on the Media tab in the Resource Area.
2. Select Videos from the Resource Library on the left.
3. Right-click on any video and select the option to Edit Video Properties.
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4. The Video Properties editor will appear, allowing you to customize properties of the
video such as volume, aspect ratio, Mark In and Mark Out points, etc.

Properties Tab

1. Play / Pause: The play/pause button starts and stops the video playback.
2. Fast-Forward / Rewind: Single clicking skips forward or backward one chapter.
Holding the FFW or RWD buttons down will fast forward or rewind the video.
3. Continuous Play / Repeat: button allows you to loop the dvd clip you are viewing or
let it stop at the end of the clip.
4. Mute & Volume: button and volume slider only controls the audio while working with
the DVD clip. The audio will not be muted on playback.
5. Title : Type the name of the DVD clip in this field.
6. Thumbnail: Click the thumbnail box on the right to set the thumbnail. (This takes a
snapshot of what is currently in the player window.)
7. Clip Properties: Start Position is the time at which the DVD clip will start. Use the up
and down arrows to manually adjust the time. Mark In sets the start position of the
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DVD clip. Click this button as the DVD clips plays to set the start position. End
Position is the time at which the DVD clip will end. Use the up and down arrows to
manually adjust the time. Mark Out sets the end position. Click this button as the DVD
clips plays to set the end position. Reset simply resets the Start and End Points.
8. Media Usage changes how the background image behaves.
Selecting the Picture icon
Selecting the Movie icon

stretches the image to fill the screen and loops.
does not stretch the video or image and does not

loop if the background is a video.
9. The Repeating selector determines how a video will behave.
10. Aspect Ratio: Allows you to maintain the aspect ratio, stretch or zoom the video.
11. Audio Properties: Allows you to change the volume of the DVD clip when you go
live with it. The volume slider allows you to set the volume of the DVD clip for
playback to the audience. Mute allows you to mute the audio on the DVD clip if you
don’t wish to use the audio portion of the DVD.

Info Tab
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1. Title: Enter the name of the video clip in this field.
2. Author: Enter the Author in this field.
3. Copyright: Enter copyright info in this field.
4. © Button: Pressing the copyright logo button adds the copyright logo to the
copyright field.
5. Description: This drop down allows you to enter a description for the video clip.
6. Tags: This drop-down allows you to enter tags for the clip.

Back to Top

- 118 -

EasyWorship 6 Manual: Backup and Transfer Your Database

BACKUP AND TRANSFER YOUR DATABASE
The following instructions will help you transfer the EasyWorship database from one
computer to another. Before starting this process, you will need a USB flash drive or
external hard drive.

BACKUP AND TRANSFER EASYWORSHIP 6 DATABASE TO
ANOTHER EASYWORSHIP 6 COMPUTER
Backup Your Database
1. Connect your backup drive to the computer.
2. Close all other programs before starting.
3. Open EasyWorship 6.
4. Click Profiles > Profiles Manager....
5. Select the desired profile. Click on the link next to Instance Location.
6. Close the Profile Editor and EasyWorship (behind the file manager window that
appears).
7. In the file manager window that appeared during step 5, select all folders.
8. Right-click and select Send to > and select the backup drive.
9. When the files are all transferred, disconnect the drive from the computer.

Restore Your Database
1. Connect your backup drive to the computer to which you wish to restore the
database.
2. Close all other programs before starting.
3. Open the file manager, or click on Computer and browse to your backup drive.
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4. Select the folders you backed up and press Ctrl+c or right-click and click Copy .
5. Open EasyWorship.
6. Click Profiles > Profiles Manager....
7. Select the profile to which you wish to restore the database.
8. Click on the link next to Instance Location
9. Close the Profile Editor and EasyWorship (behind the file manager window that
appears).
10. Rename all of the folders in the window that appears in step 7 by adding a 1 after the
folder name.
11. Right-click on a blank area (make sure you are not right-clicking any folders you
renamed) then click Paste or press Ctrl+v to paste.
12. Open EasyWorship to verify your database has transferred successfully.

TRANSFER DATABASE FROM EASYWORSHIP 2007/2009 TO
EASYWORSHIP 6 COMPUTER
On the EasyWorship 2007 or 2009 computer
1. Open EasyWorship 2009 on the old computer.
2. Click Profiles > Profiles Manager....
3. Select the profile you normally use.
4. Click the field below Use an existing application data instance and use the right
arrow key to move the cursor to the end of the field.
5. Write down the path shown there, including the name of the folder at the end of that
path.
6. Close the Profile Editor and EasyWorship.
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7. Open Windows Explorer or Computer. Browse to the folders in the path written down
in Step 5. The typical location is c:\users\public\public
documents\softouch\easyworship
8. Copy the profile folder you are using to a flash drive.
9. Take the flash drive to the EasyWorship 6 computer.

On the EasyWorship 6 Computer
1. With EasyWorship 6 closed, browse to the backup drive.
2. Right-click on the profile folder and click copy.
Browse to c:\users\public\public documents\softouch\easyworship
3. If a folder with the same name is already there (example: default), rename it to a
different name.
4. Right-click on a blank area of the window and click Paste, making sure you are not
pasting into the folder you just renamed.
5. Open EasyWorship 6 and allow it to convert the database.

If you do not have a profile with the same name as the folder you transferred.
1. Open EasyWorship 6.
2. Click Profiles > Profiles Manager....
3. Click the + button to add a new profile.
4. Enter the name of the folder you transferred into the profile name file.
5. Select the Advanced tab and change the type to Existing. Click OK.
6. You will be prompted to convert the database.
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I HAVE A NEW COMPUTER - WHAT DO I DO?
1. On the new computer go to www.easyworship.com/support.
2. Download and install EasyWorship 6.
3. Register EasyWorship 6. See Video: How to Register EasyWorship 6
4. Transfer the database from the old computer using the Transfer Your Database
instructions.
5. Install Quicktime Player from the help menu in EasyWorship 6.
6. Install DScaler video decoder for Playing DVDs from the Video Decoders article.
7. Set up your monitors using the instructions in the Dual Monitor Setup article.
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VIDEO DECODERS
In this article:
1. What Is a Video Decoder?
2. Install Quicktime for MP4 and MOV files
3. Install DScaler for DVD Playback

WHAT IS A VIDEO DECODER?
When you play a video or sound file through EasyWorship, it has to know how to decode
that file. A codec or decoder is a piece of software that tells EasyWorship how to decode
the video or audio file. If you don't have the proper codec installed on your computer,
EasyWorship won't be able to play your multimedia file. EasyWorship requires Quicktime
player in order to play MP4, M4A, M4V, and MOV files. Use the instructions below to
install Quicktime. EasyWorship also requires the DScaler decoder to play DVDs.
Instructions for downloading and installing the DScaler decoder are also provided below.

INSTALL QUICKTIME FOR MP4 AND MOV FILES
1. In EasyWorship, click Help> Install Quicktime Support.
2. Click Download on the Install Quicktime box that appears.
3. Your web browser will open and direct you to the Quicktime download page.
4. You do not have to enter any information on this page, just click the blue Download
Now button.
5. After downloading the Quicktime installer, open it and install it using the default
options provided in the install wizard.
6. Close and reopen EasyWorship. EasyWorship is now able to play MP4, M4V, M4A,
and MOV files.
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INSTALL DSCALER FOR DVD PLAYBACK
1. Close EasyWorship.
2. Click here to access the DScaler download page at sourceforge.net.
3. The download should start automatically. If not, click the direct link option provided.
Don't click any other links or buttons on this page.
4. Run the downloaded file to install DScaler. Use the default settings to complete the
installation.
5. Open EasyWorship and click on Edit > Options....
6. Click Advanced. Ensure that you have checked the box next to Use preferred
DVD video codecs and click OK.
NOTE:EasyWorship will support WMV and WMA files without the use of additional video
decoders.

Back to Top
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ALPHA CHANNEL SETUP
In this article:
1. What Is Alpha Channel?
2. Before Getting Started
3. Enable Alpha Key in EasyWorship
4. Enable Windows Extended Desktop

WHAT IS ALPHA CHANNEL?
Alpha channel is basically a mask. It determines how an object's pixel colors are going to
blend with pixel colors from another object when the two are overlaid. In EasyWorship,
when placing text (e.g., lyrics) or a transparent PNG (e.g., church logo) on top of a motion
background or live feed, alpha channel is the best way to generate clean, professional
edges around the text--especially important for IMAG, live stream, or HD broadcast.
EasyWorship's alpha channel support was designed for those who have a video mixer
that uses alpha key to overlay text and graphics on a video source. Alpha channel keying
provides the best quality for text and graphic overlays.

BEFORE GETTING STARTED
Alpha channel support requires a single NVIDIA Geforce GTX series graphics card that
can support at least three simultaneous video outputs. Before using the alpha channel
function in EasyWorship, make sure your computer meets the system requirements for
alpha channel support. Connect the alpha channel and EasyWorship Output to the video
mixer and extend the Windows desktop to each output (see Enable Windows Extended
Desktop below).
The following instructions show you how to set up EasyWorship. They will not help you
configure your video mixer. Please consult the support resources for your mixer for help
configuring an alpha key on the video mixer.
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ENABLE ALPHA KEY IN EASYWORSHIP
1. Open the EasyWorship program.
2. In the main menu at the top, select Edit.
3. From the drop-down, select Options.... The Options window will appear.
4. Change the Output Monitor option to the output you wish to use.
5. Change the alpha channel option to the output you wish to use for the alpha channel.
6. Select OK.
NOTE: If all of the video outputs do not appear in the drop-down boxes make sure the
desktop is extended to all displays. See Enable Windows Extended Desktop below.

Back to Top

ENABLE WINDOWS EXTENDED DESKTOP
1. Open EasyWorship.
2. Select the Edit menu.
3. Select Options.... The Options window will appear.
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4. Select the Live tab on the upper left.
5. In the section titled Live Options, select the Monitor Setup button.
6. EasyWorship will open the Screen Resolution dialog box.
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7. Select a monitor that is not enabled.
8. Next to Multiple displays, select Extend these displays (repeat for all inactive
displays).
9. Select Apply. The desktop will extend for 15 seconds and a prompt will ask you if you
want to keep the settings. Select Yes if you wish to keep the settings. The settings
will revert back if you don’t select yes.
10. Select OK.

NOTE: If there is only one monitor in the Screen Resolution window or you are unable
to extend the desktop to monitor, your video card may not support multiple displays, or
all video outputs may not be connected to a display.
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NEWTEK NETWORK SOURCE SETUP
EasyWorship can be configured to be a network source for the NewTek Tricaster video
mixers over your local area network. It only takes a few clicks to set up EasyWorship so
that it can be used a network source for the Tricaster.
1. Open EasyWorship.
2. Click Edit > Options.... The Options window appears.
3. In the Live tab change the Output Monitor to NewTek AirSend.
4. Select the Output Format you wish to send to the Tricaster unit from the drop-down
box.
5. On the Tricaster you can now select the EasyWorship computer as a network input.
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PROFILES
In This Article:
1. Understanding Profiles
2. Create a New Profile
3. Create a Shared Database
4. Change Profiles
5. Edit a Profile
6. Locate Your Profile Data

UNDERSTANDING PROFILES
Profiles consist of both User Settings and Application data. User Settings consist of
settings like font size, color and transition settings, as well as information about the
EasyWorship window size and location. Application Data consists of databases such as
songs and backgrounds, along with videos, images, feeds, and DVD clips. Settings like
the output monitor setting are global settings that will affect all users and are not part of
Profile settings.
What is the benefit of using Profiles? With a little bit of up front effort, Profiles let you store
databases in different locations and then associate multiple unique user settings to that
application data. Stated more simply, if Bob runs EasyWorship for the adults and Jennifer
runs EasyWorship for the youth group, they can both have access to the same resources
(songs, backgrounds, videos, etc.), but have completely different user settings so
EasyWorship looks, acts, and displays the way that fits their unique audience. Or, Bob
and Jennifer can create completely separate databases for their resources.
NOTE: The profile data can be stored on the local hard drive, on a server, or shared network
folder. EasyWorship will create a Default profile in the following location:
C:\Users\Public\Public Documents\Softouch\EasyWorship.
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Possible Profile Configurations
1. Use the same set of application data as another profile but different user settings.
(Example: Bob and Jennifer share the same resources [songs, backgrounds,
videos], but have different user settings so that Bob's slides are appropriate for the
adults and Jennifer's slides are appropriate for the youth.)
2. Use a different set of application data with the same user settings as another profile.
(Example: Bob and Jennifer have separate databases, so they don't mix resources
[songs, backgrounds, videos] but they have identical user settings.)
3. Use a different set of application data and a different set of user settings. (Example:
Bob and Jennifer have separate databases, so they don't mix resources [songs,
backgrounds, videos] and they also have different user settings.)
NOTE: EasyWorship also allows for easy hot swapping between Profiles. This means that
EasyWorship doesn't have to be closed when switching from one Profile to another.

Back to Top

The Profiles Menu
When you click Profiles in EasyWorship's main menu, you'll notice multiple options. At the
top are the names of all available Profiles that have been created. "Default" is listed as the
only available Profile until additional Profiles have been created). To change Profiles,
select the desired profile.
1. Profiles Manager allows you to edit and create profiles in EasyWorship.
2. Database Tools has a Rebuild/Fix Database option. This checks the database for
errors and fixes them.

CREATE A NEW PROFILE
EasyWorship will create a default profile automatically when it is installed. If another set of
data or settings is desired, creating a new profile can accommodate this need.
1. Click Profiles > Profiles Manager.

- 131 -

EasyWorship 6 Manual: Profiles

2. The Profile Editor screen appears.

3. Click New or the Add (+) button to open the Add Profile menu.
4. Enter a name for the new profile (e.g., Youth, Pastor, Children, Spanish, etc.). The
"Start using this profile when finished" option is checked by default. If you do not
want to use the profile immediately, un-check this option.
5. Click on the Advanced tab to specify if you want to create a new Profile or use an
existing profile by clicking on the Type drop-down menu box. You can also set a
location other than the default path (such as a network drive or another location on
the local hard disk).
6. Click OK to create the new Profile.
7. Once you have created the new Profile, you can create another profile, edit an
existing profile, or click Close.
NOTE: The default path location for Windows Vista, 7, and 8 will be located in
C:\Users\Public\Public Documents\Softouch\EasyWorship
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Create a Shared Database
1. Click Profiles > Profiles Manager.
2. The Profile Editor screen appears.
3. Click New or the Add (+) button to open the Add Profile menu.
4. Enter a name for the new profile (e.g., Youth, Pastor, Children, Spanish, etc.). The
"Start using this profile when finished" option is checked by default. If you do not
want to use the profile immediately, un-check this option.
5. Click the Advanced tab.
6. Change the Type to Existing.
7. Click the Browse button. This will open the Browse for Folder window.
8. Navigate to the shared profile folder. For network databases, browse to Network
Computer Name (e.g., WorshipPC)\ Users\Public\Public
Documents\Softouch\EasyWorship\
9. Select the profile folder (e.g., Default ).
10. Under Options, click in the open field and type in the name you want to use for this
profile's options, or select a name from the drop-down list.
11. Click OK.
NOTE: If you want to return to the Profiles Manager after creating the new profile, uncheck
the option for "Start Using this profile when complete."

Back to Top

CHANGE PROFILES
EasyWorship allows you to change profiles easily, giving you the ability to use different
databases and settings without closing the application.
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1. Click on Profiles in EasyWorship's main menu.
2. Select the Profile you want to use.
3. EasyWorship will load that profile. If you have a Schedule open, EasyWorship will
ask you to close it before loading the selected profile.
NOTE: Determining which profile is currently loaded is also easy. The current profile is the
one with a black dot on it when you click on the Profiles menu.

EDIT A PROFILE
To change the settings or folder location of a profile:
1. Click Profiles > Profiles Manager.
2. Select the profile to be edited.
3. Click the Edit button.
4. The Edit Profile window appears.
5. Click the Advanced tab. From here, you can change the Type of profile from
Existing to New, specify where the profile is located, and change the Options that
are associated with the profile.

LOCATE YOUR PROFILE DATA
You may eventually need to transfer your database from one computer to another, or
copy videos or images into the Resources folder. To find the location of the data for your
Profile, use the following steps:
1. Click Profiles > Profiles Manager.
2. Select the desired profile.
3. Click on the link next to Instance Location. This will open the Default folder where
your Resources folder is located.
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NOTE: The databases will be stored in a Databases folder in a folder called Data.
Videos and Images will be stored in the Resources folder. Options for the profile will be
stored in the Options folder.
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SONGS: PRINTING & REPORTING
EasyWorship allows you to track song usage and generate song reports. EasyWorship
also has the option to print a list of the songs in your Songs Library. Each time you add,
print, or project a song, EasyWorship tracks that action and stores it for you in a viewable
and printable file.
NOTE: To learn more about reporting the usage of songs for copyright purposes, please
contact Christian Copyright License International (CCLI) at www.CCLI.com.

PRINTING A SONG ACTIVITY REPORT
1. Click File > Print > Print Song Activity Report....
2. The Select Report Period window will appear. Enter the desire report period dates
and click OK.
3. When the report appears, use the tools at the top of the page for navigation, saving,
printing, etc.

PRINTING A SONG LIST REPORT
1. Click File > Print > Print Song List Report....
2. The Song List will appear showing the alphabetical listing of the songs in your Songs
Library. Use the tools at the top of the page for navigation, saving, printing, etc.

PRINTING A SCHEDULE
Maybe you want your staff to be able to reference a hard copy of the service or event
schedule. No problem. EasyWorship lets you print a service schedule in either a summary
or detail view.
1. With the desired schedule open in EasyWorship, click File > Print > Print Schedule
(Summary)...or Print Schedule (Details)....
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A Schedule Summary includes a summary of all of the media included in your
schedule.
A Detailed Schedule allows you to print each song or item in the schedule, page
by page, including all the words on each slide of that song, and the song
information of copyrights, author, etc.
2. Use the tools at the top of the page for navigation, saving, printing, etc.

Back to Top
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WHEN TO USE CUSTOM POSITION
If you're building EasyWorship Schedules at home or using Display Foldback with the
Matrox DualHead2Go, then you need to understand how to take advantage of custom
position for the Output Monitor.

BUILDING SCHEDULES AT HOME
If a schedule is built on a computer using a different output resolution than the
presentation computer, the songs will not display the same way on the presentation
computer as the source computer. Setting a custom resolution on the source computer
will correct this problem.

On the Presentation Computer
Determine the output screen size of the presentation computer.
1. Open Display Settings on the presentation computer.
2. Click on the second monitor.
3. The resolution for that screen will be displayed there, e.g., 1024x768.

On the Home Computer
1. In EasyWorship, click Options.
2. Under Live, select Output Monitor and change it to Custom Position.
3. Change the Width and Height to match the presentation computer resolution (e.g.,
Width = 1024p x Height = 768p).
4. Click OK.

USING DISPLAY FOLDBACK WITH A MATROX DUALHEAD2GO
To find out how to set Custom Position for Display Foldback, see Display Foldback
(Stage Display).
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USING A PRESENTER REMOTE
If you have at least EasyWorship 6.1.5, you can use a presenter remote to control
EasyWorship. If you had a programmable remote setup to work with EasyWorship 2007
or 2009, it should work with EasyWorship 6.
The standard hotkeys for EasyWorship 6 are: PgDown = Go Live, Arrow Down = Next
Slide, Arrow Up = Previous Slide.
If you have a presenter remote that cannot be programmed to match EasyWorship
hotkeys, follow the instructions below.

CHANGING HOTKEYS USING THE HOTKEY INSTALLER
You can download hotkeys file that will work for most presenter remotes.
1. Close EasyWorship 6.
2. Click Here to download the hotkey installer.
3. Allow the file to run and replace any files it asks to replace.
4. Open EasyWorship and test your remote. Make sure you click in the live area with
your mouse when testing.
5. If you wish to reset the hotkeys file to the default settings, download and run the
Hotkeys Reset file.

CHANGING HOTKEYS MANUALLY
1. Close EasyWorship 6.
2. Go to Start > Run or right-click the start button and click Run.
3. In the Run box that appears type in %programdata% and press Enter.
4. Navigate to and double-click Softouch > EasyWorship.v6.1 > Settings.
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5. Open HotKeys.ini in a simple text editor, such as Notepad. The following
information is displayed.
[HotKeys]
BlackScreenKeys=C-66
ClearScreenKeys=C-67
GoLiveNextKeys=34
GoLivePrevKeys=33
JumpBridgeKeys=66
JumpChorusKeys=67
JumpEndingKeys=69
JumpIntroKeys=73
JumpPreChorusKeys=82
JumpSlideKeys=83
JumpTagKeys=84
JumpVerseKeys=86
LogoScreenKeys=C-76
ScheduleNextKeys=39
SchedulePrevKeys=37
SlideFirstKeys=36
SlideLastKeys=35
SlideNextKeys=78, 40, 32
SlidePrevKeys=80, 38, 8
If your remote is moving you to the next item in the schedule, it uses Page Up
and Page Down to navigate slides. Make the following changes.
Change GoLiveNextKeys to 0 (zero).
Add 34 to SlideNextKeys (SlideNextKeys=78, 40, 32, 34).
Change GoLivePrevious to 0 (zero).
Add 33 to SlidePrevKeys (SlidePrevKeys=80, 38, 8, 33).
If you are using a remote that is selecting the next or previous item in the
schedule but not going live, you have a remote that uses left and right arrow
keys to navigate slides. Make the following changes.
Change ScheduleNextKeys to 0 (zero)
Add 39 to SlideNextKeys (SlideNextKeys=78, 40, 32, 39)
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Change SchedulePrevKeys to 0 (zero)
Add 37 to SlidePrevKeys (SlidePrevKeys=80, 38, 8, 37)
8. Save the file and close Notepad.
9. Open EasyWorship 6 and go live with a song or presentation to test the remote
settings.
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